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Introduction

Real System 5.0 is today’s most powerful solution for streaming real-time live
and on-demand audio and video over the Internet and corporate intranets. This
guide explains how to create and manage RealAudio and RealVideo content
using RealEncoder 5.0 or RealPublisher 5.0 and, in some cases, information
about creating and managing content using RealAudio Encoder 3.0 or 3.1.

Streaming and Real-Time Delivery

RealSystem 5.0 enables streaming audio and video for reliable transmission
under real-life conditions. Streaming is the latest technology for audio and
video available and allows the audio or video clip to play as soon as it starts
being received by your computer. Real-time delivery means that you do not
have to wait while a file downloads; the clip plays as soon as your computer
starts to receive it. You also have complete control over the clip; you can pause,
move forward and back, and start or stop at any time.

Performance Range

With RealEncoder and RealPublisher you can choose to deliver a range of
performance through ordinary modem connections all the way to corporate
Intranet LANs. You can also maximize the available bandwidth to meet the
demands of the content, for example, a music video requires different emphasis
than a simple speech.

RealAudio and RealVideo formats are optimized for low-to-high speed
connections including 14.4 and 28.8 Kbps modems, ISDN, T1 and LAN. You
can also listen or view RealAudio and RealVideo files stored locally on your
computer.
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Content Sources

You can acquire content from a variety of sources:

• pre-existing audio and video files, for example, .wav for audio and .avi and
.mov for video

• pre-recorded or live content from audio and video devices, such as
cameras, microphones, audiotape, videotape, or satellite feeds.

RealEncoder and RealPublisher create on-demand content that users can access
whenever they choose and can be created in all screen sizes. It can be played
from standard Web servers or from RealNetworks RealServer for higher
reliability. Live audio and video require a RealNetworks RealServer.

Web Page Creation and Publishing

In addition to the features found in RealEncoder, RealPublisher offers new Web
publishing features:

• automatic HTML page creation

• easy uploading of HTML pages to your Web server and/or RealServer with
the click of a few buttons

Web page creation and publishing can be accomplished using the step-by-step
wizards included in Real Publisher. RealPublisher also provides options for
display of your RealAudio or RealVideo clip on your Web page.

Basic Steps to Adding Streaming Media to
Your Web Site

1. Select audio and video content from a variety of sources:
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• pre-existing audio and video files, including .wav, .avi,
.au and .mov file formats

• live sources such as video cameras, microphones,
audiotape, videotape and satellite feeds

2. Compress, or encode, your source audio and video to create RealAudio and
RealVideo files in several ways with:

• pre-defined templates that automatically calculate audio
and video bandwidth options for the modem connection
delivering your content

• multiple templates to deliver content over different
modem connections from a single web page link

• self-customized templates for advanced users

3. Create Web pages (with RealPublisher)

• that are linked to your RealAudio and RealVideo files and
launch the RealPlayer

• that function as plug-ins and ActiveX controls

4. Publish Web pages and media files to a Web server and/or RealServer
(RealPublisher only)
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Using this Guide

ReaAudio and RealVideo Content Creation Guide is intended for people who
are familiar with operating World Wide Web servers and with RealNetworks
technology. You do not need previous experience using RealEncoder or
RealPublisher, but you do need to know how to create directories or folders,
copy files, and open text files.

Organization
This manual is organized in two sections:

Section 1: Overview

Shows the components and features of RealSystem 5.0. Diagrams illustrate the
relationships between client and server for video and multimedia delivery.

Section 2: Content Creation

Explains how to create and manage video and multimedia content for delivery
by RealServer and a Web server. The chapters are:

Installing RealEncoder and RealPublisher: Explains how to install
RealEncoder and RealPublisher.

System Requirements: Discusses hardware requirements for Windows 95/NT
and Macintosh.

Using RealEncoder and RealPublisher: Information about how to prepare
files for encoding, which encoding  settings to use and how to encode static and
live files using RealEncoder, RealPublisher or Adobe Premiere.

Delivering Live Content: Explains how to deliver live video, including setting up
RealNetworks RealServer and advertising your event on the Timecast Web site
(http://www.timecast.com).

Bandwidth Negotiation: Explains how to create bandwidth negotiated files and
bandwidth file organization.

RealEncoder Plug-In for Adobe Premiere: Explains how to encode files within
Adobe Premiere.
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Synchronized Multimedia: Discusses how to create a synchronized
multimedia presentation with RealEncoder and RealPublisher and create events
files.

Editing RealAudio and RealVideo Files: Explains how to use editing tools to
change the static information in a file, alter the data with basic functions like
cut and paste, and examine the contents of a file.

Publishing Your Files to the Web: Discusses how to generate Web (HTML)
pages and publish those Web pages along with  RealAudio and RealVideo files
to a standard HTTP Web server or a RealServer.

Live Broadcasting: Explains how to advertise your live events.

Delivering Live Content: Explains how to deliver content for broadcasting live
events.

Simulating a Live Broadcast: Information on how to play an existingmedia
file as if it were a live event.

Configuring Your Web Site: Explains the many ways you can deliver
RealAudio and RealVideo clips from your Web site, including HTTP
streaming, Netscape plug-in, ActiveX object, and JavaScript.

Conventions

This manual uses the following conventions:

Command Monospace font represents commands to be typed or
information displayed on the screen.

<file name> Angle brackets show where to insert information, such
as the name and location of a file.

[    ] Square brackets show optional command arguments.

Bold Bold font is used for names of files, directories,
commands, and options.
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Overview

Before you create and manage RealAudio and RealVideo content you must
understand how the system works. This chapter describes the basic features and
primary components of RealSystem 5.0 and how they work together.

RealAudio and RealVideo Clips

A RealAudio or RealVideo clip is a file or live broadcast containing sound and
video encoded in RealAudio or RealVideo format. These formats are highly
compressed to deliver the best possible sound and video over a limited-
bandwidth connection. Your audio and video can be stored for later use,
broadcast live over a network, or simultaneously stored as a file for later use
while it’s being broadcast live.

Because there is no single best format for delivering audio and video, clips can
be optimized differently for different kinds of content. You can choose to
provide a clip in one or more formats based on the type of content and the
available bandwidth. For example, you would use a different format to deliver
speech over a 14.4 Kbps modem than you would to deliver a music video over
an ISDN connection.

Components of RealSystem 5.0

RealAudio and RealVideo use a client-server system. The server provides the
content to the client over a network. The basic components of  RealSystem 5.0
are:

RealPlayer - The client program that enables users to see and listen to
RealAudio and RealVideo clips. Special purpose player components enable
ActiveX and Netscape plug-in capabilities.



  Overview

7

C
O
N
T
E
N
T

C
R
E
A
T
I
O
N

RealEncoder/RealPublisher - The program that creates RealAudio and
RealVideo clips. The input to this program can be a digitized audio clip, a live
audio signal, a digitized video clip or a live video signal.

RealMedia Tools - The tools programs that can be used to modify RealAudio
and RealVideo clips, including RMTools, RMMerge, RMCut, RMEdit,
RMPaste and RM Dump.

RealServer - The server program that delivers RealAudio and RealVideo clips
over a network. One RealNetworks RealServer can deliver clips to hundreds of
Players at the same time.

Web Browser - The client program that enables users to find most RealAudio
and RealVideo clips. The Web browser is also used to display the visual part of
Synchronized Multimedia presentations. RealAudio and RealVideo work with
all popular Web browsers.

Web Server - The server program that delivers Web pages. Typically,
RealAudio and RealVideo clips are accessed by clicking a link on a Web page.
The Web server also delivers the visual part of Synchronized Multimedia
presentations. HTTP streaming of RealAudio or RealVideo files enables content
providers to stream RealAudio and RealVideo clips from a World Wide Web
server. While this method is not as robust, it provides a reasonable method for
providing short RealAudio and RealVideo content to a limited number of users.
RealAudio and RealVideo works with all popular Web servers.
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RealAudio and RealVideo Files and
Metafiles

RealAudio and RealVideo use several file types, each identified by a specific
file extension. The files and their file extensions are:

RealAudio (.ra) clip - Audio encoded clip. This file is created with the older
RealAudio Encoder.

RealMedia clip (.rm) - Audio or video clips encoded with RealVideo Encoder
4.0, RealEncoder 5.0 and RealPublisher 5.0. Files created with RealEncoder or
RealPublisher and delivered by the RealServer can contain multiple streams,
including audio, video, image maps, and events. Video files can contain audio
and video or video only and can be played with RealPlayer. Audio only files can
be played by RealPlayer.

RealMedia metafile (.ram) - The file that is used as an alias or pointer on a
Web page to one or more RealAudio or RealVideo clips. The metafile contains
the URL of one or more RealAudio (.ra) and RealVideo (.rm) files located on a
Web server or a RealNetworks RealServer. The metafile is typically located on
a Web server and is linked on a Web page.

RealPlayer plug-in metafile (.rpm) - The same as a metafile, but used with
RealPlayer plug-in for Netscape Navigator and Internet Explorer 3.0 and later.
RealAudio Event (.rae) The event file is used in synchronized multimedia. It is
created with one of several event compiler utilities which comes bundled with
the RealAudio and RealEncoders and RealPublishers.

Windows

The RealAudio Encoder 3.0 events compiler is “Cevent32.exe.” The compiler
for RealVideo Encoder 4.0, RealEncoder 5.0 and RealPublisher 5.0 is built into
the RMMerge utility.

Macintosh

The 3.0 RealAudio Encoder events compiler is “RA Event Compiler.”
The compiler for RealVideo Encoder 4.0, RealEncoder 5.0 and RealPublisher
5.0 is not supported for Macintosh.
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Delivering a RealAudio or RealVideo Clip

The following figure shows how typical RealAudio and RealAudio clips are
delivered. The numbers in the figure match the numbered steps following the
figure.
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RealAudio and RealVideo Delivery System
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1. The Web browser displays a Web page that contains a link to a metafile.

2. The user clicks the link. The Web browser requests the metafile from the
Web Server.

3. The Web server delivers a metafile to the Web browser.

4. The Web browser looks up the MIME type of metafile. Based on the
MIME type, the Web browser starts RealPlayer as a helper application and
passes it the metafile.

5. RealPlayer reads the first URL from the metafile and requests it from
RealNetworksRealServer (although it could also be located on a Web
server.

6. The server begins streaming the requested RealAudio or RealVideo clip to
RealPlayer.

Note:  No messages pass between the RealServer and the Web server. The Web
browser provides the URL of RealAudio or RealVideo clip to RealPlayer.
RealPlayer does not require a Web browser to function; users can enter the URL
of a .ra, .rm or .ram file directly into RealPlayer, or use the Preset or Scan
buttons on RealPlayer Plus.
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Delivering Synchronized Multimedia

Synchronized Multimedia delivery works like regular RealAudio or RealVideo
delivery, with one extra step between RealPlayer and the Web browser.

The following figure shows how a typical RealAudio or RealVideo
Synchronized Multimedia presentation. The numbers in the figure match the
numbered steps following the figure.
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Media Delivery System

1. The Web browser displays a Web page that contains a link to a metafile.

2. The user clicks on the link. The Web browser requests the metafile from
the Web Server.
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3. The Web server delivers a metafile to the Web browser.

4. The Web browser looks up the MIME type of metafile. Based on the
MIME type, the Web browser starts RealPlayer as a helper application and
passes it the metafile.

5. RealPlayer reads the first URL from the metafile and requests it from
RealServer.

6. RealServer begins streaming the requested RealAudio or RealVideo clip to
RealPlayer.

7. RealServer concurrently notifies RealPlayer via an event file (.rae) when an
event should occur. For more information see the “Using Synchronized
Multimedia with Bandwidth Negotiation” section of the “Synchronized
Multimedia” chapter.

8. RealPlayer sends the URL for the event to the default Web browser for
viewing.

Static Encoding

RealAudio and RealVideo clips may be created from previously captured digital
audio or video files. With static encoding, these files are compressed and are
converted to RealAudio and RealVideo formats.

Modifying RealAudio and RealVideo Clips

When you encode a RealAudio or RealVideo clip, both RealEncoder and
RealPublisher create a new file with a .rm file extension. The original file is not
modified. Encoding a RealAudio or RealVideo clip is a one-way process; you
cannot convert a RealAudio and RealVideo file back into the original source
format. If you want to be able to encode other formats in the future, you need to
archive the original source.
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It is possible to modify some attributes of RealAudio and RealVideo clips
without re-encoding them, such as Title, Author and Copyright  and enabling
or disabling Mobile Playbac and Selective Record.

Live Encoding

The source of a RealAudio or RealVideo clip can also be live input. The
encoded RealAudio or RealVideo clip can be broadcast live over a network,
stored as a file for later use, or it can be simultaneously stored as a file, or
archived, and broadcast live.

RealEncoder and RealPublisher for Windows can encode a live input source.
RealEncoder for the Macintosh cannot encode a live input source, and there is
no Macintosh version of RealPublisher.

Live broadcasting requires a license and a RealNetworks RealServer.

Title, Author, and Copyright

RealAudio and RealVideo clips include text strings for the title, author, and
copyright. This text is displayed by RealPlayer when the clip is played.
Although the player usually labels the text as title, author, and copyright, the
player displays whatever text you choose to supply.

You enter the title, author, and copyright text when encoding a clip. You can
change this text after encoding by using the metafile. For information on
metafiles, refer to the “Configuring Your Web Site” chapter. You can also
change the text by using RMEdit and RMTools.
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RealEncoder and RealPublisher
Installation

Installing RealEncoder and RealPublisher is quick and easy. You can download
the RealEncoder or RealPublisher from the RealNetworks Web site or install it
from the RealServer CD-ROM.

Installing RealEncoder and RealPublisher
on Windows Platform

To download the install program from the Intenet:

1. With a Web browser, go to the RealNetworks Web site:

                    http://www.real.com

2. Go to the RealSystem 5.0 Products page, then to RealEncoder or
RealPublisher 5.0 download pages to download the installer.

3. When prompted, click the Save to Disk button and specify a temporary
directory for the installation program. Note where you saved it.

4. In File Manager or Explorer, double-click the installation icon in the
temporary directory to activate the automated installation process.
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To install RealPublisher setup program from CD-ROM:

1. Insert the CD-ROM into the drive

2. Follow the prompts.

To complete the installation of RealEncoder or RealPublisher:

1. Close any other applications that may be open and click Next.

2. To accept the terms and conditions for installing RealEncoder or
RealPublisher, click Next.

3. Enter your name, company or organization name, and e-mail address.
Then click Next.

4. If you are installing RealPublisher, you will be prompted to select the
Internet Service Provider you will use to upload your RealAudio and
RealVideo-enabled Web pages to a remote server.  Select Generic−−No
Defaults if your Internet Service Provider is not listed.

5. To install RealEncoder or RealPublisher into the default directory, click
Next. If you wish to install the encoder in a different location, click
Browse and select the directory into which you want to it.

6. If you are installing over an existing RealVideo, RealAudio Encoder,
RealEncoder or RealPublisher for which you have defined custom
templates, select Keep Existing Templates if you want to preserve the
custom templates.

7. To finish the installation, click Finish.

8. Click OK.
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Installing RealEncoder on Macintosh
Platform

To download the install program from the Intenet:

1. With a Web browser, download the installer from the RealNetworks Web
site:

                    http://www.real.com

2. Go to the RealSystem 5.0 Products page, then to the RealEncoder 5.0
download page.

3. Depending on the options set in your Web brower, you may be prompted to
specify a directory for the installation program; otherwise it will download
to a default directory.

4. The file will be downloaded as an HQX file and will need StuffIt Expander
or similar utility to convert it to a Macintosh executable.

5. After conversion, double-click the installation icon to activate the
automated installation process.

To complete the installation of RealEncoder:

1. To accept the terms and conditions for installing RealEncoder, click
Continue.

2. To install the encoder into the default directory, select the folder you wish
to install the encoder into and click Install.

3. If you are installing over an existing RealVideo, RealAudio Encoder, or
RealEncoder for which you have defined custom templates, your previous
templates will be merged with newly-installed templates.

4. To finish the installation, click Finish.

5. Click Quit.
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Files Installed by RealEncoder and
RealPublisher for Windows

The following files are installed in the RealEncoder/RealPublisher directory
(\Real\RVEncode by default in Windows):

File Description

enclic An ASCII text file that contains the license
agreement for the encoder.

EX-RM.prm Adobe Premiere plug-in.

graphic.gif Real logo.

pninet.dll A dynamic link library used for Internet functions.

pntouch.dll A dynamic link library used for registration.

pnWebpub.dll A dynamic link library used for Web publishing.

Readme.htm Information about Encoder installation and
operation.

rmcut.exe A utility that returns a copy of the stream from start
to endtime without modifying the original source.

rmdump.exe A utility used to examine the contents of a
RealAudio or RealVideo file.

rmedit.exe A utility used to modify the title, author, copyright,
comment, mime type, or stream name of a
RealAudio or RealVideo file.

rmevents.dll A dynamic link library used by the rmmerge utility.

rmimap.dll A dynamic link library used by the rmmerge utility.



RealAudio and RealVideo Content Creation Guide

18

File Description

rmmerge.exe A utility used to create a Synchronized Multimedia
presentation.

rmpaste.exe A utility used to re-sort from bandwidth to
timestamp order.

rmtools.exe GUI for showing stream number and name, mime
type, start and endtime of source and destination
files and for performing basic editing on these files

rvbatch.exe Lets you run the encoder from a batch file as a
command-line tool.

rvencode.exe The RealEncoder/RealPublisher executable.

rvslta RealVideo Simulated Live Transfer Agent.
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Files Installed by RealEncoder for
Macintosh

File Description
graphic.gif Real logo.

License agreement Contains the license agreement
for the encoder.

RVBatch An Applescriptable Encoder

RealVideo Encoder Adobe Premiere plug-in.

RVEncoder The Encoder application

ReadMe.html Information file

Sample Script Applescript demonstrating use of
the RVBatch utility.

RealAudio Exporter RealAudio Exporter add-on for
SoundEdit 16
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System Requirements

This section outlines the basic hardware and software requirements to create
RealAudio and RealVideo content. It contains information about the technical
specifications for static encoding, used for creating on-demand content and
instructions for live encoding which enables real-time live broadcasting.

Real Encoder and RealPublisher compresses high-bandwidth video signals to a
low-bandwidth signal. This compression allows for the real-time transmission
of clips via the Internet, even over a connection as slow as a 14.4 Kbps modem.

RealAudio content consists of audio only while RealVideo content can consist
of audio and video or video only.

RealEncoder 5.0 is available for:

• Windows 95 (static and live content)

• Windows NT 3.5 and 4.0 (static and live content)

• Macintosh (static content)

RealPublisher 5.0 is available for:

• Windows 95 (static and live content)

• Windows NT 3.5 and 4.0 (static and live content)



  System Requirements

21

C
O
N
T
E
N
T

C
R
E
A
T
I
O
N

Windows 95 and Windows NT System
Requirements

Static and Live Encoding RealAudio for Windows 95/NT
Different hardware is required for encoding an audio file and encoding a live
audio stream.

Requirement Minimum Recommended

CPU 486/66 DX Pentium 586, 75MHz

RAM 8 MB 8 MB required, 16
MB recommended

Hard Disk space (software) 1 MB 1 MB

Sound Card 16-bit sound card or better
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Static Encoding RealVideo for Windows 95/NT

Requirement Minimum Recommended

CPU 486/66 DX Pentium 120

RAM 16 MB 64 MB

Hard Disk space (software) 4 MB 4 MB

Hard Disk space (data) 500 MB 1 GB

Color Display 16-bit 24-bit (TrueColor)

Video Capture Card* Any quality capture card which can
produce .avi or .mov files

Sound Card* 16-bit sound card or better

*Video and sound cards are needed only for capture-to-file encoding and are
not necessary for encoding of pre-existing AVI or QuickTime files. See the
“Using RealEncoder and RealPublisher” chapter for more information on live
capture-to-file encoding.
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 Live Encoding RealVideo for Windows 95/NT

Live capture and live encoding uses content from a variety of sources:

• • VHS, S-VHS or Beta-SP tape

• • live video camera and microphones

• any other analog video or audio source

High quality live encoding takes longer and requires greater computing
resources than lower quality.  Here are the requirements for encoding at low
and high frame rates:

Requirement Low Frame
Rate
(less than 3 fps)

High Frame
Rate
(more than 3 fps)

Recommended
for High Frame
Rate
or Large Screen
Sizes

OS Windows 95 Windows NT

Computer Pentium 166
MHz

Pentium 200 MHz Dual Pentium 2

RAM 32MB 64MB

Hard Drive 1GB 1GB

Color Display 16-bit 24-bit (TrueColor)

Video
Capture Card

Any native
Video-for-
Windows capable
capture card

Osprey 100, Osprey 1000

Sound Card 16-bit sound card
or better

16-bit sound card or better

Note:  Slower machines also give reasonable results in Slide Show mode, at
1fps.
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Capturing video puts a burden on your computer’s ability to write to your hard
drive.  Special hard drives exist for capturing video called AV drives. If you do
not use one of these special drives, frames may be dropped during the capture
process when the hard drive re-calibrates itself periodically. If you experience
dropped frames with a standard drive, you can re-capture the video.

Macintosh Requirements

For Macintosh users, RealEncoder supports only static encoding for video and
audio. It does not support live video or audio encoding. 68K Macintosh
computers are also not supported. RealPublisher is not available for Macintosh
users.

Static Encoding RealAudio and RealVideo for the Macintosh

Requirement Minimum Recommended

CPU Any Power PC 604 Power PC

RAM 16 MB 32 MB

Hard Disk space (software) 4 MB 4 MB

Hard Disk space (data) 500 MB 1 GB

Operating System 7.5.5 8.0

Note:  RAM requirements may be slightly less for RealAudio.
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Using RealEncoder and
RealPublisher

This chapter details RealEncoder and RealPublisher operations, including
supported input formats, output options, and how to achieve the best possible
audio and video quality.

RealEncoder allows two types of encoding:

• static encoding for pre-existing audio and video files
 (Windows and Macintosh)

• live encoding, for live broadcasting and archival purposes
(Windows only)

RealPublisher allows two types of encoding:

• static encoding for pre-existing audio and video files
 (Windows only)

• live encoding, for live broadcasting and archival purposes
(Windows only)

RealEncoder and RealPublisher enable you to compress video files or input
from a video device into one or more RealAudio or RealVideo formats. Output
can be sent to a file or directly to a RealNetworks RealServer for live
broadcasting.

You can select input files by browsing from within RealEncoder or
RealPublisher, or you can drag-and-drop files for automated processing. The
Encoder window displays information about input and output file formats and
has fields for entering descriptive information. You can specify options such as
the compression type and copyright string to be included in the output file.

Some video editing programs can encode and write files in RealVideo format.
For example, a RealEncoder plug-in is available for Adobe Premiere.
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There is a difference between encoding from a live source and broadcasting a
live event. Broadcasting from a live source requires a special license purchased
with your RealNetworks RealServer. For information about serving a live
stream refer to the “Delivering Live Content” chapter.

Source Files for Static Encoding

RealAudio and RealVideo clips may be created from previously captured digital
audio or video files.

Video Formats Supported by RealEncoder

For Windows:

• Video for Windows (.avi).  RealEncoder accepts compressed or
uncompressed formats, although it is recommended you use uncompressed
formats whenever possible.

• QuickTime for Windows (.mov).  Only uncompressed files are supported.

For Macintosh:

• Quicktime for Macintosh (.mov). Uncompressed files and some
compressed files are supported. Compressed files supported are Cinepak
files and Apple’s Video Compressor. It is recommended, however, you use
uncompressed formats whenever possible.

Audio Formats Supported by RealEncoder

It is recommended that you use uncompressed files whenever possible.

For Windows:

• Waveform (.wav). RealEncoder accept compressed or uncompressed
formats, although it is recommended you use uncompressed files.
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• QuickTime for Windows (.mov)

• Audio (.au)

• Sound (.snd)

 For Macintosh:

• Audio Interchange File (.aif)

• Waveform (.wav)

• QuickTime for Macintosh (.mov)

• Audio (.au)

• Sound (.snd)

Video Formats Supported for RealPublisher

• Video for Windows (.avi). .  RealPublisher accepts compressed or
uncompressed formats, although it is recommended you use uncompressed
formats whenever possible.

• QuickTime for Windows (.mov)

The following audio formats are supported by RealPublisher. It is
recommended that you use uncompressed files whenever possible:

Audio Formats Supported for RealPublisher

• Waveform (.wav). RealPublisher accepts compressed or uncompressed
formats, although it is recommended you use uncompressed files.

• QuickTime for Windows (.mov)

• Audio (.au)

• Sound (.snd)
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AVI Requirements

• AVI files should have a color depth of 24-bits.

• The standard video frame size for the Internet is 176 x 128, however
height and width must both be divisible by 16. Height and width can also
be 160 x 120, the only size not divisible by 16.

• File should be uncompressed for best results.

• Indeo drivers must be installed on your machine for the encoder to be able
to open .avi files created with the YUV9 format. Indeo drivers are available
from the Intel Web site at www.indeo.com. However, if you captured an
.avi file on the same machine as RealEncoder or RealPublisher, the
encoder typically has no problem opening it.

To determine if you have the AVI video codec for a particular AVI file:

1. Right-click the file name.

2. Click Properties.

3. Click Details tab. Look at the Video Format field.
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 If the Video Format field says "Unknown format" most likely the
corresponding AVI video codec is not installed.

4. If the Video Format field lists a format, click Preview tab. You should be
able to view the video in the preview window.

 

Note: If you can preview the video, and still receive an error when encoding the
AVI file, the file may not be in 24-bit color. You can convert the file to 24-bit
file using a third-party video editing tool like Adobe Premiere.

QuickTime Requirements

• 24-bit RGB QuickTime video files

• 8- 16-bit mono and stereo audio

• On Windows platforms for RealEncoder and RealPublisher, files must
be uncompressed.

• On Macintosh platforms for RealEncoder only, files can be
uncompressed or compressed (Cinepak, Apple’s Video Compressor, or
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Raw), but it is recommended you use compressed files whenever
possible.

Encoding RealAudio or RealVideo Files for
Windows

The following procedure shows RealPublisher screens. RealEncoder procedures
are similar.

To create a RealAudio or RealVideo file from an existing audio or video file using
RealEncoder or RealPublisher for Windows:  

1. Start RealPublisher. The RealPublisher window opens:
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2. Click Open Session from the File menu. The Open Session window appears:

 

3. In the source pane, verify that File is selected.

4. Click Add. The Add Source File dialog box appears.

5. Select the file you want to encode. Click Open.

6. In the destination pane, verify RealMedia File is checked.

7. Click Save As. The Select Destination File dialog box appears.

8. Choose a directory to store the file and enter the destination file name.

9. Click Save.

10. Click OK. The Open Session window closes.

11. In the properties pane, you can enter the Title, Author, and Copyright
information for your output file. These fields are optional.

12. Click Mobile Playback if you wish to create content that can be
downloaded by RealPlayers and transferred to Mobile Players such as the
Audible Player for time-shifted playback.

 The Audible Player currently supports the 6.5 Kbps voice codec that is
available as part of the RealEncoder 5.0 and RealPublisher 5.0 products.
Contact your Mobile Playback vendor if you need more information.
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13. If you wish RealPlayer and RealPlayer Plus users to be able to save your
RealVideo or RealAudio signal to disk, click Selective Record.

14. In the encoding templates list box, select the template for the target
audience you want your file to play for.

15. Click Start to begin the encoding process. When encoding is complete, an
Encoding Complete message appears indicating the bit rate the file was
encoded at.

 If RealPublisher is unable to encode the file at the selected bit rate, you
may need to re-encode the file with a different template. To edit your
template settings, click Advanced and re-encode your file with the updated
template.

16. View the encoded file with RealPlayer.

Encoding RealAudio or RealVideo Files for
Macintosh

To create a RealAudio or RealVideo file from an existing audio or video file using
RealEncoder on Macintosh:   

1. Start RealEncoder. The RealEncoder window opens:
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2. Click Open Session from the File menu. The Open Session window appears:

 

3. In the source pane, verify that File is selected.

4. Click Add. The Add Source File dialog box appears.

5. Select the file you want to encode. Click Open. The Add Source File
dialog box closes.

6. In the destination pane, verify RealMedia File is checked.

7. Click Save As. The Select Destination File dialog box appears.

8. Choose a directory to store the file and enter the destination file name.

9. Click Save.

10. Click OK. The Open Session window closes.

 Note:  The Capture Device and RealServer options in the Open Session
window are for live encoding and are not available for Macintosh users.

11. In the properties pane of the RealEncoder window, you can enter the Title,
Author, and Copyright information for your output file. These fields are
optional.

12. Click Mobile Playback if you wish to create content that can be
downloaded by RealPlayers and transferred to Mobile Players such as the
Audible Player for time-shifted playback.
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 The Audible Player currently supports the 6.5 Kbps voice codec that is
available as part of the RealEncoder 5.0. Contact your Mobile Playback
vendor if you need more information.

13. If you wish RealPlayer and RealPlayer Plus users to be able to save your
RealVideo or RealAudio signal to disk, click Selective Record.

14. In the encoding templates list box, select the template for the target
audience you want your file to play for.

15. Click Start to begin the encoding process. When encoding is complete, an
Encoding Complete message appears indicating the bit rate the file was
encoded at.

 If RealEncoder is unable to encode the file at the selected bit rate, you may
need to re-encode the file with a different template. To edit your template
settings, click Advanced and re-encode your file with the updated
template.

16. View the encoded file with RealPlayer.

Command Line Encoding for Windows

In some situations you may find it convenient to batch encode live or on-
demand content. Within the DOS command line, you can automatically encode
several files sequentially. The following syntax is used:

RVBatch RVEncode.exe <options>

where options are any of RealEncoder or RealPublisher options described
below.  To see a full listing of the parameters and options, from the Rvencode
directory type:

RVBatch RVEncode.exe /?
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 Command Line Batch Encoding Options

Option Description ( defaults in parenthesis )

/I Use this option to specify an Input File

/O Use this option to specify an outfile or dir - Output File Name or
Directory (infile.rm or dir\YYYYMMDDHHMMSS.rm)

/L Use this option to specify Use Live Input

/S Use this option to specify "server[:port]/file" - Server Name,
Port and File. (Port 7070)

/W Use this option to specify password - Server Password

/D Use this option to specify hhh:mm:ss - Maximum Encoding
Duration (continuous)

/A Use this option to specify an Audio Codec (0)

/V Use this option to specify a Video Codec (0)

/F Use this option to specify a framerate - Frame Rate. (Optimal)

/B Use this option to specify Total Kbps for clip. (100)

/N Encoding Speed range 1 to 5 where 1 = Normal, 5 = fastest( 1 )

/M Optimal Framerate Bias 1 = Sharpest Image, 3 = Smoothest
Motion (2)

/Q Use this option to specify Quality 1-100. (100)

/T Use this option to specify a Clip Title

/U Use this option to specify a Clip Author

/C Use this option to specify a Clip Copyright

/K Use this option to Enable Mobile Playback. Valid options are:

0 Disabled
1 Enabled
(1)

/R Use this option to Enable Selective Record. Valid options are:

0 Disabled
1 Enabled
(0)
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Option Description ( defaults in parenthesis )

/X Use this option to Enable Audio Encoding. Valid options are:

0 Disabled
1 Enabled
(1)

/Y Use this option to Enable Video Encoding. Valid options are:

0 Disabled
1 Enabled
(1)

Z Cropping Values : Left, Top, Width, Height (0,0,0,0)

/? Use this option to Display the HELP information

Batch Encoding for Macintosh

In some situations you may find it convenient to batch encode files. With
AppleScript you can automatically encode several files sequentially. The
following table describes the encoding parameters for Macintosh. These can
also be obtained by opening the RVBatch Dictionary which was installed with
RealEncoder.

 To open the dictionary using ScriptEditor:

1. Select Open Dictionary from the File menu. The Get File window
appears.

2.  Double click RVBatch.

Encoding Parameters

The audio and video codec names requested below are the same as those in the
RealEncoder user interface.
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Encoding Parameters

Parameter Description

encode Use this option to specify an Input File

output Use this option to specify an FSSpec or full
pathname of output file

audio Enable audio encoding

using audio codec Audio codec name

video Enable video encoding

using video codec Video codec name

at frame rate Frame rate

optimal bias Determines the behavior of optimized
encoding and can be one of the following
options:  Sharpest Image, Normal or
Smoothest Motion

at bitrate Total bit rate

cropping Sets the cropping rectangle and follows this
form: top, left, bottom, right

at quality Video quality setting (1-100)

encoding speed speed of encoding−the faster the speed the
less the quality of the encoding. Can be one
of the following options:  Normal, Medium,
Fast, Faster, or Fastest

title Title string

author Author string

copyright Copyright string

Mobile Playback Enable Mobile Playback

Selective Record Enable Selective Record
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Setting the Timeout Value

Before encoding, look at the sample script which shows an example of how to
use the RVBatch. This file is installed in the RealEncoder folder.  Notice the
Timeout command.  When encoding using an actual script, be sure to change
the default Timeout value of 60 seconds to a value which is much greater, for
example, 99999. This ensures adequate time for encoding all batch files.

For more information refer to:
www.real.com

Using and Creating Templates

An encoding template allows you to specify bandwidth options for your content,
whether for audio only, video only, or audio and video.

RealEncoder and RealPublisher come with pre-defined templates that enable
you to encode your content specifically for your target audience. Each template
is optimized for a particular type of audio and video content as well as for
bandwidth. For a list of templates, refer to the “Pre-Defined Templates” section
in this chapter.

You can adjust these templates or define a new one to optimize the type of
audio and video you are encoding. For information about creating templates,
refer to the “Creating New Templates” section in this chapter.

You can select one or more templates that best suit your needs, and the
RealServer can deliver clips encoded using these multiple templates. In this
way, you can reach the widest possible audience while still providing high-
bandwidth users with the best listening experience. For more information about
multiple templates, see the chapter “Using RealEncoder and RealPublisher.”

Taking it a step further, by using Bandwidth Negotiation you can configure
your site to automatically serve the appropriately encoded file. For more
information on this, refer to the “Bandwidth Negotiation” chapter.
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Bandwidth

Understanding bandwidth is an important part of using templates. Bandwidth,
also known as bit rate, is the amount of data that can be received by your
modem during a set period of time. Bandwidth is measured in kilobits per
second (Kbps). Standard modems are commonly referred to by the bit rate they
are able to receive, for example, 14.4, 28.8, and 56. These designations may
already be familiar to you.

In addition to standard bandwidths, you can encode clips for bit rates up to 500
Kbps. These higher bandwidths, however, are generally more typical of
corporate intranets.

Pre-defined Templates

Each template is optimized for a particular type of audio and video content as
well as for bandwidth. You can select one or more templates that best suit your
needs.
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RealEncoder and RealPublisher Pre-Defined Templates

Template Name Audio Codec Video Bit
Rate
(Kbps)

Total Bit
Rate
(Kbps)

Video Frame
Rate

Audio 14.4, Voice 8.5 Kbps Voice 0.0 8.5

Audio 28.8, Music -
Mono

16 Kbps Music
- High
Response

0.0 16

Audio 28.8, Voice 16 Kbps Voice
- Wideband

0.0 16

Audio 28.8, Music -
Stereo

20 Kbps Music
Stereo

0.0 20

Video 28.8, High
Action

6.5 Kbps Voice 13.5 20 Optimal Sharp

Video 28.8, Slide
Show

12 Kbps Music 8.0 20 . 25

Video 28.8, Talking
Heads

5Kbps Voice 13.5 20 Optimal
Smooth

Audio 56K Dial-Up
Modem, Music -
Mono

32Kbps Music
Mono

0.0 32

Audio 56K Dial-Up
Modem, Music -
Stereo

32Kbps Music
Stereo

0.0 32

Video 56K Dial-Up
Modem, Music

12 Kbps Music 22.0 34 Optimal
Smooth

Video 56K Dial-Up
Modem, Voice

6.5 Kbps Voice 27.5 34 Optimal
Smooth
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Template Name Audio Codec Video Bit
Rate
(Kbps)

Total Bit
Rate (Kbps)

Video
Frame Rate

Audio 56K ISDN,
Music – Mono

40 Kbps Music
Mono

0.0 40

Audio 56K ISDN,
Music – Stereo

40 Kbps Music
- Stereo

0.0 40

Video 56K ISDN,
Music

16 Kbps Music
- High
Response

29.0 45 Optimal
Smooth

Video 56K ISDN,
Voice

8.5 Kbps Voice 36.5 45 Optimal
Smooth

Audio 112K, Dual
ISDN,  Music -
Mono

80Kbps Music
Mono

0.0 80

Audio 112K, Dual
ISDN, Music -
Stereo

80 Kbps Music
- Stereo

0.0 80

Video 112K Dual
ISDN, Music

16 Kbps Music
- High
Response

64.0 80 Optimal
Normal

Video 112K Dual
ISDN, Voice

16 Kbps Voice
- Wideband

64.0 80 Optimal
Normal

Video High-Bite
Rate 200K, Music

16 Kbps Music
- High
Response

184.0 200 Optimal
Normal

Video High-Bite
Rate 200K, Voice

16 Kbps Voice
- Wideband

184.0 200 Optimal
Normal
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Template Name Audio Codec Video Bit
Rate
(Kbps)

Total Bit
Rate (Kbps)

Video
Frame Rate

Video High-Bite
Rate 300K, Music

16 Kbps Music
- High
Response

284.0 300 Optimal
Normal

Video High-Bite
Rate 300K, Voice

16 Kbps Voice
- Wideband

284.0 300 Optimal
Normal

Notice that the total bit rate is a combination of the audio codec and the video
bit rate. The total bit rate for each template is about 25% less than the total bit
rate of the bandwidth of the connection to compensate for connection and
packet overhead.

Multi-Template Encoding and Bandwidth Negotiation

The RealNetworks RealServer can deliver clips encoded using multiple
templates. In this way, you can reach the widest possible audience while still
providing high-bandwidth users with the best viewing and listening experience.

You can encode more than one RealAudio or RealVideo file at the same time
using multi-template encoding. This allows you to encode your files with
different compression rates based on the bandwidth capability of the user.

Multiple templates generate multiple output files. You can use multiple
templates for testing or to allow the user to choose to stream the best file for the
user’s bandwidth. Your Web site must have a separate hypertext link and Web
page for each format or template.

However, using bandwidth negotiation with multi-template encoding requires
only one link on your Web site to a particular clip, regardless of the number of
files and enables the server to automatically stream the best file for the user’s
stated bandwidth. Encoding files with the bandwidth negotiation option is
discussed in the “Bandwidth Negotiation” chapter.
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To encode a file with multiple templates:

1. Start RealEncoder or RealPublisher from your desktop and follow steps 1-
13 for encoding audio and video files. See the “Encoding Audio or Video
Files” section of this chapter.

2. In the encoding templates listbox, select one or more templates by holding
down the Control key as you click each template name.

3. Click Start to begin multiple template encoding.

4. The Multiple Template Encoding dialog box appears.

 Each template should be a different data rate, for example a 28 Kbps
template, a 56 Kbps template and a 200 Kbps template.

5. Follow steps 15-16 for encoding audio and video files. See the “Encoding
an Audio or Video File” section in the “Using RealEncoder and
RealPublisher” chapter.

6. Click Begin. The encoding process starts.

 The Multiple Template dialog box will remain visible during encoding,
and you will be able to monitor audio levels.

7. Click OK when the “Encoding Complete message” appears.

8. You will not be able to preview the bandwidth negotiated files until the
directory containing the files is posted on a RealNetworks RealServer.  If
you encoded them as individual files, you may now view them with the
RealPlayer.

Creating New Templates

Each audio-only template is comprised of an audio codec. Each video template
is comprised of an audio codec, video bit rate, total bit rate, frame rate, and
encoding speed. The quality of encoded output is affected by these and by the
actual media contents, such as fixed camera shots, more or less motion, and
multiple camera shots.
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If one of the templates does not achieve the effect you are looking for, try
creating a new template by basing it on a pre-defined template and then
modifying the settings. When you encode live content, you will probably need
to create a new template also.

Setting Command Line Parameters to Achieve Total Bit
Rates

RealVideo parameters that can be adjusted to obtain the preferred total bit rate
are as follows:

• audio codec

• video bit rate

When deciding which parameters to set, the total bit rate must be considered.
The total bit rate is the actual bit rate at which the video or audio file is
encoded. If the target bit rate is 28.8 Kbps, then the total bit rate should be 20
Kbps, approximately 25% less that the target bit rate. The following are the
recommended total bit rates for common bandwidths:

 Recommended Total Bit Rates for Common Bandwidths

Target Bit Rate Total Bit Rate

28.8 Kbps 19 or 20 Kbps

56.0 Kbps dial-up modems 34 Kbps

56.0 Kbps (ISDN) 45 Kbps

112 (Dual ISDN) 80 Kbps

For a video file, select the total bit rate according to the table above, and then
from the table below, choose an audio codec if you are using video with audio.
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Audio Codecs

Command
Line

Parameter

Bandwidth Audio Codec

sipr 0 6.5 Kbps 6.5 Kbps voice

sipr 1 8.5 Kbps 8.5 Kbps voice

sipr 2 5 Kbps 5 Kbps voice

sipr 3 16 Kbps 16 Kbps - Wideband

dnet 0 16 Kbps 16 Kbps music Low Response

dnet 1 16 Kbps 16 Kbps music Medium Response

dnet 2 16 Kbps 16 Kbps music High Response

dnet 3 20 Kbps 20 Kbps music stereo

dnet 4 40 Kbps 40 Kbps music mono

dnet 5 40 Kbps 40 Kbps music stereo

dnet 6 80 Kbps 80 Kbps music mono

dnet 7 80 Kbps 80 Kbps stereo

dnet 8 8 Kbps 8 Kbps music

dnet 9 12 Kbps 12 Kbps music

dnet 10 32 Kbps 32 Kbps music mono

dnet 11 32 Kpbs 32 Kbps music stereo

28_8 0 15.2 Kbps 15.2 Kbps voice

Since RealAudio codecs have discreet bandwidths, the video bit rate is the
difference between the total bit rate and the bit rate of the chosen audio codec:

Video Bit Rate = (Total Bit Rate) - (Bit Rate of Audio Codec)

In RealEncoder and RealPublisher , the video bit rate is calculated
automatically. There are two video codecs:

Parameter Video Codec
0 RealVideo (Standard)
1 RealVideo (Fractal)
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Next choose a frame rate. Not all content types support high frame rates for a
given bandwidth. The highest frame rate that can be achieved at 20 Kbps is 15
frames per second (fps) for Talking Head type content. Different content types
require different frame rates. For example, while Talking Heads at 20 Kbps
might support 10 fps, music videos may only support 3 fps or less.

If you are getting high levels of latency, you are exceeding the bounds of your
content type.

To reduce latency levels:

• Choose Optimize Frame Rate. This lets the encoder adjust the frame rate.

 You can select Optimized Frame Rate when using the RealVideo
(Standard) codec. Optimized Frame Rate provides constant image clarity,
or sharpness, and variable frame rates. When this option is selected, the
encoder automatically selects the frame rate.

 For example, if a person who is talking begins to gesture or move around
quickly, the frame rate increases as the motion speeds up and decreases as
the motion slows down. The image sharpness remains constant throughout.

• Reduce the screen size (176 x 128 is recommended). Use numbers divisible
by 16 in setting frame size. Height and width can also be 160 x 120, the
only size not divisible by 16.

 
• Lower the frame rate.

 Fixed Frame Rate is adjusted by moving the slider. Fixed Frame Rate
gives you the option of choosing to emphasize image clarity or motion
smoothness.

 For example, if your content contains a lot of motion, set the slider closer
to the 15 fps setting. The resulting video image will be less clear but will
exhibit smoother motion, i.e., more frames per second.

 However, if your content has less motion, set the slider closer to the .050
fps setting. The resulting video images will be more clear but will exhibit
less smooth motion, i.e. fewer frames per second.
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To create a new template for Windows:

1. In the templates pane, click Advanced. The Advanced Setting window
appears:

 

2. Enter the name of the new template in the Template Name field and click
Save.

 You should not directly modify the pre-defined templates. If you want to
change some of the settings of a pre-defined template, save it as a new
template by giving it a new name. This way you don’t overwrite the pre-
defined templates.

3. Select an audio codec. They are arranged by data rate and type of content.

4. Select a Video codec. RealPublisher has two video codecs available,
RealVideo (Standard) and RealVideo (Fractal).

5. Select the total bit rate for the entire encoded file. The video bit rate will be
total bit rate less the audio bit rate.
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 You should reduce the expected total bit rate by 25% to compensate for
connection and packet overhead. For example, choose 20 Kbps for a 28.8
Kbps modem.

6. Choose Optimize Frame Rate. This lets the encoder adjust the frame rate.

 You can select Optimized Frame Rate when using the RealVideo
(Standard) codec. Optimized Frame Rate provides constant image clarity,
or sharpness, and variable frame rates. When this option is selected, the
encoder automatically selects the frame rate.

 For example, if a person who is talking begins to gesture or move around
quickly, the frame rate increases as the motion speeds up and decreases as
the motion slows down. The image sharpness remains constant throughout.

 Fixed Frame Rate is adjusted by moving the slider. Fixed Frame Rate
gives you the option of choosing to emphasize image clarity or motion
smoothness.

 For example, if your content contains a lot of motion, set the slider closer
to the 15 fps setting. The resulting video image will be less clear but will
exhibit smoother motion, i.e., more frames per second.

 However, if your content has less motion, set the slider closer to the .050
fps setting. The resulting video images will be more clear but will exhibit
less smooth motion, i.e. fewer frames per second.

7. Click Save to save the template.

8. Click Close to close the Advanced Settings window.
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To create a new template for Macintosh:

1. In the templates pane, click Advanced. The Advanced Setting window
appears:

 

2. From the Templates pop-up listbox, select Custom.

3. Select an audio codec. They are arranged by data rate and type of content.

4. Select a Video codec. RealPublisher has two video codecs available,
RealVideo (Standard) and RealVideo (Fractal).

5. Select the total bit rate for the entire encoded file. The video bit rate will be
total bit rate less the audio bit rate.

6. Once you have selected your settings, the Template Name window appears.

7. Enter the name of the new template in the Template Name field and click
OK.

 You should not directly modify the pre-defined templates. If you want to
change some of the settings of a pre-defined template, save it as a new
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template by giving it a new name. This way you don’t overwrite the pre-
defined templates.

 You should reduce the expected total bit rate by 25% to compensate for
connection and packet overhead. For example, choose 20 Kbps for a 28.8
Kbps modem.

8. Choose Optimize Frame Rate. This lets the encoder adjust the frame rate.

 You can select Optimized Frame Rate when using the RealVideo
(Standard) codec. Optimized Frame Rate provides constant image clarity,
or sharpness, and variable frame rates. When this option is selected, the
encoder automatically selects the frame rate.

 For example, if a person who is talking begins to gesture or move around
quickly, the frame rate increases as the motion speeds up and decreases as
the motion slows down. The image sharpness remains constant throughout.

 Fixed Frame Rate is adjusted by moving the slider. Fixed Frame Rate
gives you the option of choosing to emphasize image clarity or motion
smoothness.

 For example, if your content contains a lot of motion, set the slider closer
to the 15 fps setting. The resulting video image will be less clear but will
exhibit smoother motion, i.e., more frames per second.

 However, if your content has less motion, set the slider closer to the .050
fps setting. The resulting video images will be more clear but will exhibit
less smooth motion, i.e. fewer frames per second.

9. Click Save to save the template.

10. Click Close to close the Advanced Settings window.
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Performance Tips and Tricks

Drag-and-Drop Encoding for Windows

RealEncoder and RealPublisher for Windows support drag-and-drop encoding:

• Click an input-video-file icon and drag it onto an open RealPublisher or
RealEncoder window. This enters path and file name information into the
appropriate Encoder fields.

• Then you only need to enter the descriptive information and settings and
click Start to begin the encoding process.

Image Size

RealEncoder and RealPublisher support any size image that is divisible by 16.
Height and width can also be 160 x 120, the only size supported that is not
divisible by 16. Live capture image size is controlled through Set Video
Format under the Options menu and is dependent upon the video capture
hardware installed.

If you want to embed RealPlayer controls in your Web page, be sure you embed
it using the same image size as when the clip was originally encoded.  For
example, if the image size of your encoded clip is 176 x 128, do not use 320 x
240 to embed it in your Web page. See the “Custom Controls for RealAudio
and RealVideo” section in the “Congfiguring Your Web Site” chapter for more
information on embedding RealPlayer controls.

Image Cropping

1. To encode only part of the screen, select Crop Enabled from the Options
menu. To edit the image cropping settings, select Crop Settings from the
Options menu.  The Image Cropping window displays. Notice the crop
lines around the image. These lines show the portion of the image that will



RealAudio and RealVideo Content Creation Guide

52

be encoded. Use Left, Top, Width, and Height to adjust the size and
location of crop lines.

2. If you need to edit the crop settings, select Crop Settings from the Options
menu.

3. Click the Start button to start the encoding process. When file encoding is
complete, an Encoding Complete message appears indicating the bit rate
the file was encoded at.

 If RealPublisher is unable to encode the file of the selected bit rate, you
need to re-encode the file with a different template.

4. View the encoded file with RealPlayer.
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Volume Control

1. Select Volume Control from the Options menu.  The Volume Control
window displays.

2. Select Properties from the Options menu.  The Properties window
displays.

3. Click Recording to adjust the input recording volume. (Playback adjusts
the level of the volume you hear while you are encoding, not the volume
the end-user hears.)
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4. Select from the list of volume controls the type of inputs you will be using
and click OK. The Volume Control window will display the volume
controls you select.

5.  Select which recording inputs to use by clicking and checking the Select
box for each input.

6.  Adjust the sound level by moving the sliders up or down. Remember, if the
volume is too high, the encoded sound may be clipped and appear
distorted.  If the volume is too low, it will be difficult to hear. Use the audio
level meter in the RealEncoder window to monitor the level during
encoding.

 Repeat previous steps 10-16 only if the audio meter in the RealEncoder or
RealPublisher window indicates the input signal is too low.

7.  Close the Recording Control window and return to the RealEncoder or
RealPublisher window.

Using the Audio Level Meter

While you encode RealAudio or RealVideo you can monitor the audio input
level to be sure you are encoding the optimal dynamic range. Green indicates a
normal reading. Red warns that you are close to an over-modulated input. The
best sound quality will occur when the top red bar is often lit but the clipping
indicator never goes off.
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Producing High Quality Video

To create the best possible streaming audio and video, you must start with the
best possible source material. Different video formats yield different qualities
when captured or “digitized.” Because RealAudio and RealVideo compression
algorithms are lossy, some of the information contained in your original input
is not included in the reconstructed signal sent to RealPlayer.

In particular, different video formats yield different qualities when digitized.
Additionally, video playback devices commonly have two types of video
outputs, S-video and composite.  S-video produces better results.

The common video input devices in order of quality are:

1. Betacam-sp, also known simply as Beta. This format is common among
video production professionals.

2. Laserdisc

3. S-VHS or Super-VHS

4. VHS

Satellite television services (e.g. Direct TV) have extremely high quality video.
Their feed quality typically exceeds that of Laserdisc.
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Content Elements that Affect Video Quality

Below are content elements that can affect the quality of a video encoding at 20
Kbps:

Content Type Expected Encoding Results

Fixed camera shot, low motion Clean frames, with high frame rates

Fixed camera shot, medium
motion

Clean frames, somewhat lower frame
rates

Multiple camera shots, low
motion

Clean frames with 1 fps or less

Zoom with low motion Clean frames with moderate frame rate

Fixed camera shot, high motion Clean frames with moderate frame rate

Multiple camera shots, high
motion

Clean frames with less than 1 fps

Note:  RealEncoder and RealPublisher produce significantly better frames with
higher frame rates when used with bandwidths higher than 28.8 Kbps.

Producing High Quality Audio

• Use high quality source files or recording input device.

• If you are not doing a live broadcast, capture or “digitize” the sound to a
supported file format such as a  .wav, mov, or .aif whenever possible.

• Digitizing the sound before encoding the file allows you to use a sound
editor to adjust the amplitude of your signal to maximize the available
dynamic range.  If you do not adjust the signal, the resulting RealAudio
and RealVideo files may sound flat.

• If your original audio file signal exceeds the acceptable amplitude range,
the file may be “cliped.” Clipping can give rise to clicks or pops on
playback. If your source file contains a clipped signal, your final RealAudio
or RealVideo file will have high-frequency background noise or static.
Lowering the input volume will help reduce clipping.

• Eliminate any DC offset either while recording or later with an audio
editor. This removes low frequency noise.
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• When encoding live-source audio, you have less opportunity to manipulate
your input signal. Be sure that volume levels are prepared and tested before
encoding.

• Cut any unnecessarily long silences from the beginning or end of the
output file to conserve space.

Live Capture-to-File

If you have a real-time capture station, you can use it to capture and compress
directly into RealAudio and RealVideo formats. To do this, use the output of a
video player and set the encoder to capture-to-file instead of capture-to-a-live-
server feed. This has the advantage of eliminating the need to create and store
intermediate AVI files which are very large and take considerable disk space. It
is also the fastest way to capture content like breaking news clips when time-to-
post is important.

Live Content Settings

Live Content should be set the same way as you would creat static files.  If you
are experiencing a lower quality or frame rate than you do with static content,
you may need a more powerful machine.

Encoding with Multiple Audio Codecs

Use a CD quality sampling rate (44.1 kHz), sampling width (16-bit) and two
channels when creating an input file that you intend to encode using multiple
audio codecs.  Stereo audio codecs will not encode mono audio input.

Synchronizing Audio with Video and Preventing Pitch Shifting

To ensure that the audio stays synchronized with video or other time critical
media and to prevent pitch shifting in audio resampling, the following
sampling rates need to be used with the following audio codecs.
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Audio Codecs and Sampling Rates

Audio Codec Sampling Rate

14.4 8, 16 or 32 kHz

5 Kbps voice 8, 16, 32 kHz

6.5 Kbps voice 8, 16 or 32 kHz

8.5 Kbps voice 8, 16 or 32 kHz

15.2 Kbps voice 8, 16 or 32 kHz

16 Kbps voice 16 or 32 kHz

8 Kbps music 8, 16 or 32 kHz

12 Kbps music 8, 16 or 32 kHz

16 Kbps music High response 11.025, 22.05 or 44.1 kHz

16 Kbps music Med response 11.025, 22.05 or 44.1 kHz

16 Kbps music Low response 8, 16 or 32 kHz

20 Kbps music stereo 8, 16 or 32 kHz

40 Kbps music mono 11.025*, 22.05 or 44.1 kHz

40 Kbps music stereo 8*, 16 or 32 kHz

80 Kbps music mono 11.025*, 22.05* or 44.1 kHz

80 Kbps music stereo 8*, 16* or 32 kHz

*  The sampling rates are lower than the default input rates of the encoder. For
fuller sound, it is recommended you use the higher sampling rates.
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 Audio Codec Reference Chart

Audio Codecs Minimum
Bandwidth
Required

Bandwidth
Negotiation

Name

Command
Line

Parameter

Input Sample
Rate

Frequency
Response

Voice

5Kbps Voice * 14.4k Modem sipr.6 sipr 2 8, 16 or 32 kHz 4 kHz

6.5Kbps Voice 14.4k Modem sipr.8 sipr 0 8, 16 or 32 kHz 4 kHz

8.5Kbps Voice 14.4k Modem sipr.10 sipr 1 8, 16 or 32 kHz 4 kHz

16Kbps Voice - Wideband * 28.8k Modem sipr.20 sipr 3 16 or 32 kHz 8 kHz

15.2Kbps Voice - RealAudio
2.0

28.8k Modem 28_8.36 28_8 0 8, 16 or 32 kHz 4 kHz

Music

8Kbps Music 14.4k Modem dnet.10 dnet 8 8, 16 or 32 kHz 4 kHz

12Kbps Music 14.4k Modem dnet.15 dnet 9 8, 16 or 32 kHz 4 kHz

16Kbps Music - High
Response

28.8k Modem dnet.20 dnet 2 11.025, 22.05 or
44.1 kHz

5.5 kHz

16Kbps Music - Medium
Response

28.8k Modem dnet.20 dnet 1 11.025, 22.05 or
44.1 kHz

4.7 kHz

16Kbps Music - Low
Response

28.8k Modem dnet.20 dnet 0 8, 16 or 32 kHz 4 kHz

20Kbps Music Stereo 28.8k Modem dnet.25 dnet 3 8, 16 or 32 kHz 4 kHz

32Kbps Music Mono * 56k Modem
(X2)

dnet.40 dnet 10 11.025, 22.05 or
44.1 kHz

8 kHz

32Kbps Music Stereo * 56k Modem
(X2)

dnet.40 dnet 11 8, 16 or 32 kHz 5.5 kHz

40Kbps Music Mono ISDN (Single) dnet.50 dnet 4 11.025*, 22.05 or
44.1 kHz

11 kHz

40Kbps Music Stereo ISDN (Single) dnet.50 dnet 5 8*, 16 or 32 kHz 8 kHz

80Kbps Music Mono Dual ISDN/T1 dnet.100 dnet 6 11.025*, 22.05*
or 44.1 kHz

20 kHz

80Kbps Music Stereo Dual ISDN/T1 dnet.100 dnet 7 8*, 16* or 32 kHz 16 kHz

* Denotes New 5.0 Audio Codecs; All others are 4.0 compatible. 2.0/1.0 (14_4.18) compatibility is no longer supported by
Encoder 5.0 or later.
Sampling rates are lower than the default input rates of the Encoder.  For fuller sound, it is recommended that you use a
higher input sampling rate.
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Bandwidth Negotiation

You can encode your files with different compression rates based on the
bandwidth capability of the user. You can choose to provide as many different
data rates for each file as you want.

The Player gets the best quality the connection can handle without having to
explicitly choose among multiple links and Web pages. You can choose to
provide as many different data rates for each file as you want. The bandwidth
negotiation process is transparent to users.

Bandwidth negotiation requires only one link on your Web site to a particular
clip. To provide content in multiple formats without bandwidth negotiation,
your Web site must have a separate hypertext link and metafile for each format.

Creating Files with the Bandwidth
Negotiation Option

To create a Web page that uses the Bandwidth Negotiation option:

1. Start RealPublisher from your desktop and follow steps 1-13 for encoding
audio and video files. See the “Encoding Audio and Video Files” section of
the “Using RealEncoder and RealPublisher” chapter.

2. In the encoding templates listbox, select one or more templates by holding
down the Control key as you click each template name.

3. Click Start to begin multi-template template encoding.

4. Typically, each template should be a different data rate.  For example you
might choose a 28 Kbps template, a 56 Kbps template and a 200 Kbps
template.
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5. The Multiple Template Encoding dialog box appears. Verify that Enable
Bandwidth Negotiation is selected. The files will automatically be named
for the server.

6. Follow steps 15-16 for encoding audio and video files.  See “Encoding an
Audio or Video File” in the “Using RealEncoder and RealPublisher”
chapter.

7. Click Begin. The encoding process starts.

 The Multi-Template dialog box will remain visible during encoding, and
you will be able to monitor audio levels.

8. Click OK when the “Encoding Complete” message appears.

9. You will not be able to preview the files until the directory containing the
files is posted on a RealNetworks RealServer.

Bandwidth File Organization

File organization is the key to bandwidth negotiation. The next figure shows a
single link on a Web page, and seven available RealVideo files encoded using
different algorithms.
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The following steps correspond to the numbers in the figure:

1. The user clicks a link to a metafile on a Web page.

2. The Web server returns the metafile to the Web browser and based on the
.ram file extension, sets the MIME type of the metafile to audio/x-pn-
RealAudio.

3. The Web browser looks up the MIME type of the metafile, starts
RealPlayer as a helper application, and passes it the metafile.

4. RealPlayer reads the first URL from the metafile and requests it from
RealServer. Based on its preference settings, RealPlayer also sends a list of
RealVideo compression types it supports.

5. RealServer checks the directory specified by the URL and begins streaming
the highest bandwidth file supported by RealPlayer.

1

4

3

2

5

Web Server

Link to Metafile

                file.ram

Web Browser

RealPlayer  Folder.rm

      pnrv.1930

      pnrv.144

      pnrv.70

      pnrv.43

      pnrv.36

      pnrv.24

      pnrv.18
      14_4.18

Real Server
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The following table shows the file name for each bandwidth and connection
type.

Connection Bandwidth (Kbps) File Name

T1 154.4 pnrv.1930

Dual ISDN 112 pnrv.144

Single ISDN 56.7 pnrv.70

56.6 56.7 pnrv.43

28.8 28.8 pnrv.36

19.2 19.2 pnrv.24

14.4 14.4 pnrv.18
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The following table shows the file formats that RealAudio Player version 1.0
through 3.0 requests and order in which they are requested:

Player Version Bandwidth Setting Files Requested

1.0 All lpcJ.18

2.0 14.4 lpcJ.18

2.0 28.8, ISDN, T1 28_8.36
lpcJ.18

2.1 14.4 lpcJ.18

2.1 28.8, ISDN, T1 28_8.36
lpcJ.18

3.0 14.4 lpcJ.18

3.0 28.8 dnet.25
dnet.20
28_8.36
lpcJ.18

3.0 ISDN dnet.50
dnet.25
dnet.20
28_8.36
lpcJ.18

3.0 T1 dnet.100
dnet.50
28_8.36
dnet.25
dnet.20
lpcJ.18

Note:  RealAudio Player 3.0 with a 28.8 Kbps connection always plays
RealAudio 2.0 - 28.8 (28_8.36) format if it is available. If you want to provide
another 28.8 format such as 28.8 Stereo (dnet.25), do not also provide the
28_8.36 format. If you do not provide any format supported by a Player, that
Player receives a message to upgrade to the current Player release.
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The following table shows the file formats that RealPlayer 4.0 and 5.0 requests
and in what order they are requested:

Player Version Bandwidth Setting Files Requested

4.0 28.8 pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.10
lpcJ.18

4.0 ISDN pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.10
dnet.10
sipr.8
lpcJ.18
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Player Version Bandwidth Setting Files Requested

4.0 Dual ISDN pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.10
dnet.10
sipr.8
lpcJ.18

4.0 T1 pnrv.1930
pnr.144
dnet.100
pnrv.70
dnet.50
pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.10
dnet.10
sipr.8
lpcJ.18



  Bandwidth Negotiation

67

C
O
N
T
E
N
T

C
R
E
A
T
I
O
N

Player Version Bandwidth Setting Files Requested

5.0 28.8 pnrv.36
dnet.25
pnrv.24
dnet.20
28_8.36
pnrv.18
dnet.15
sipr.10
lpcJ.18

5.0 56.6 pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.43
pnrv.36
dnet.25
pnrv.24
dnet.20
sipr.20
28_8.36
pnrv.18
dnet.15
sipr.20
sipr.10
sipr.6
lpcJ.18
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Player Version Bandwidth Setting Files Requested

5.0 ISDN pnr.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.43
pnrv.36
dnet.25
pnrv.24
dnet.20
sipr.20
28_8.36
pnrv.18
dnet.15
sipr.10
dnet.10
sipr.8
sipr.6
lpcJ.18

5.0 Dual ISDN pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.43
pnrv.36
dnet.25
pnrv.24
dnet.20
sipr.20
28_8.36
pnrv.18
dnet.15
sipr.10
dnet.10
sipr.8
sipr.6
lpcJ.18
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Player Version Bandwidth Setting Files Requested

5.0 T1 pnrv.1930
pnrv.144
dnet.100
pnrv.70
dnet.50
pnrv.43
pnrv.36
dnet.25
pnrv.24
dnet.20
sipr.20
28_8.36
pnrv.18
dnet.15
sipr.10
dnet.10
sipr.8
sipr.6
lpcJ.18

The following table shows the file formats that RealPlayers 4.0 and 5.0 request
from RealAudio servers 1.0 through 3.0 and RealServer 5.0. They are listed in
the order they are requested for each bandwidth setting.

The unshaded file formats can be played in real time. The file formats shaded
in gray can be played, but the player will use a buffered playback mechanism to
play the file.
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File Formats Requested by RealPlayers and RealServers

T1/LAN Dual ISDN ISDN 56.6 28.8 19.2 14.4

pnrv.1930 pnrv.144 pnrv.70 pnrv.43 pnrv.36 pnrv.24 pnrv.18

pnrv.144 dnet.100 dnet.50 pnrv.36 dnet.25 dnet.20 dnet.15

dnet.100 pnrv.70 pnrv.43 dnet.25 pnrv.24 sipr.20 sipr.10

pnrv.70 dnet.50 pnrv.36 pnrv.24 dnet.20 28_8.36 dnet10

dnet.50 pnrv.43 dnet.25 dnet.20 sipr.20 pnrv.18 sipr.8

pnrv.43 pnrv.36 pnrv.24 sipr.20 28_8.36 dnet.15 sipr.6

pnrv.36 dnet.25 dnet.20 28.8.36 pnrv.18 sipr.10 lpcJ.18

dnet.25 pnrv.24 sipr.20 pnrv.18 dnet.15 dnet10 28_8.36

pnrv.24 dnet.20 28_8.36 dnet.15 sipr.10 sipr.8 sipr.20

dnet.20 sipr.20 pnrv.18 sipr.10 dnet10 sipr.6 dnet.20

sipr.20 28_8.36 dnet.15 dnet.10 sipr.8 lpcJ.18 pnrv.24

28_8.36 pnrv.18 sipr.10 sipr.8 sipr.6 dnet.25 dnet.25

pnrv.18 dnet.15 dnet10 sipr.6 lpcJ.18 pnrv.36 pnrv.36

dnet.15 sipr.10 sipr.8 lpcJ.18 dnet.43 pnrv.43 dnet.43

sipr.10 dnet10 sipr.6 dnet.50 dnet.50 dnet.50 dnet.50

dnet10 sipr.8 lpcJ.18 pnrv.70 pnrv.70 pnrv.70 pnrv.70

sipr.8 sipr.6 dnet.100 dnet.100 dnet.100 dnet.100 dnet.100

sipr.6 lpcJ.18 pnrv.144 pnrv.144 pnrv.144 pnrv.144 pnrv.144

lpcJ.18 pnrv.1930 pnrv.1930 pnrv.1930 pnrv.1930 pnrv.1930 pnrv.1930
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Bandwidth Negotiation Example

In this example, you deliver one of three RealVideo formats depending on the
connection speed and RealPlayer version.

To setup this example:

1. Encode the source file in the following formats:

• 20 Kbps Video - 6.5 Kbps Audio

• 34 Kbps Video - 16 Kbps Audio

• 100 Kbps Video - 16 Kbps Stereo

2. Create a metafile named myvideo.ram containing a URL such as:

pnm://www.real.com/music/myvideo.rm

3. Create a link to the metafile in a Web page. The following HTML code is a
typical link:

<A HREF="http://www.real.com/myvideo.ram">
Watch myvideo</A>

4. On RealServer computer, create a directory named myvideo.rm in the
/music directory.

5. In this directory, store the three files, automatically renamed pnrv.36, etc.
as shown in the previous table.

• The file that is played depends on the Player connection and version.
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RealEncoder Plug-in for Adobe
Premiere

The RealEncoder plug-in for Adobe Premiere 4.2 exists for both Windows and
Macintosh platforms. Currently, the Windows version is installed by
RealEncoder and RealPublisher. The Windows Adobe Premiere plug-in is
installed in the /Premiere/plugins directory. The Macintosh Adobe Premiere
plug-in must be copied to the plug-in directory in the Premiere folder.

The RealEncoder Adobe Premiere plug-in does not work with Adobe Premiere
LE because Premiere LE does not support third party plug-ins.

Encoding with Adobe Premiere 4.2

Adobe Premiere is an advanced editing program that is supported by
RealEncoder and RealPublisher. RealEncoder and RealPublisher install an
Adobe Premiere plug-in, allowing you to encode directly from Premiere.

To encode RealAudio and RealVideo clips in Adobe Premiere 4.2:

1. Start Adobe Premiere 4.2.

2. Click Open from the File menu.

3. Select one of the supported file types. The file appears in the Clip window.

4. Select the Clip window.

5. Click Export from the File menu and select RealEncoder. The
RealEncoder Options window appears (Windows version):
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6. In the media options pane, select one of the pre-installed templates.

 These templates are guidelines for creating content containing both audio
and video. You can save your own templates, or delete templates that you
do not use. If you delete a template you created yourself, it will be
permanently deleted. If you delete a template which was installed by
RealEncoder, you can get it back by reinstalling RealEncoder.

 Once you have selected a template, you can change any of the audio
codecs, any of the video codec settings, or the total bit rate.

7. Click Optimized Frame Rate or Fixed Frame Rate.

 For all pre-defined templates, the default setting is Optimized Frame
Rate.

• You can select Optimized Frame Rate when using the RealVideo Standard
video codec. Optimized Frame Rate provides constant image clarity, or
sharpness, and variable frame rates. When this option is selected, the
encoder automatically selects the frame rate.

 For example, if a person who is talking begins to gesture or move around
quickly, the frame rate increases as the motion speeds up and decreases as
the motion slows down. The image sharpness remains constant throughout.
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• You can select Fixed Frame Rate when using the RealVideo Standard
video codec or the RealVideo Fractal video codec. Fixed Frame Rate is
adjusted by moving the slider. Fixed Frame Rate gives you the option of
choosing to emphasize image clarity or motion smoothness.

 For example, if your content contains a lot of motion, set the slider closer
to the 15fps setting. The resulting video image will be less clear but will
exhibit smoother motion, i.e., more frames per second.

 However, if your content has less motion, set the slider closer to the .050fps
setting. The resulting video images will be more clear but will exhibit less
smooth motion, i.e. fewer frames per second.

8. Click Save to save the template.

9. Click Close to close the Advanced Settings window.

10. In the properties pane, enter the Title, Author, and Copyright information
for your output file. These fields are optional.

11. Click Mobile Playback if you wish to create content that can be
downloaded by RealPlayers and transferred to Mobile Players such as the
Audible Player for time-shifted playback.

 The Audible Player currently supports the 6.5 Kbps voice codec that is
available as part of the RealEncoder 5.0 and RealPublisher 5.0 products.
Contact your Mobile Playback vendor if you need more information.

12. If you want to allow RealPlayer Plus users to save your clip to disk, click
Allow Selective Record.

13. In the Marker Options frame, click the appropriate option. Refer to Marker
Options for more information.

14. In the destination pane, click Select and enter the name of the output file.

15. Click Encode. Adobe Premiere begins encoding the file.

16. When the file is encoded, a Status dialog box appears, providing details
about the encoded file. Click OK.
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Marker Options

Marker options allow you to take advantage of the Marker feature in Adobe
Premiere.

• Click Off to encode the entire clip regardless of markers. Choosing this
option means that you don’t have control over which frames get encoded.

• Click Key Frames to encode a marked file. Choosing this option will
ensure that all frames that are marked are encoded.

• Click Slide Show Frames to encode only the marked frames. Choosing
this option allows you to create slide shows out of video files and gives you
control over exactly which frames you want to use.

• To set and clear numbered and unnumbered markers, first activate the
“clip”

• You can add unnumbered markers by pressing  "+" or "=" while in the clip
window.

• You can remove any marker by pressing "c" or "v".

Note:  The plug-in recognizes both Premiere’s numbered (up to 10 available)
and unnumbered markers (up to 1000 available).

Supported File Formats

The RealEncoder plug-in for Adobe Premiere supports all of the file types
supported by Adobe Premiere.

Supported Movie File formats are:

• Video for Windows (.avi)

• QuickTime for Windowsand Macintosh (.mov)

• FilmStrip (.flm)

Note:  It is strongly recommended you use uncompressed files only
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Supported audio formats are:

• Audio Interchange (.aif)

• Windows Waveform (.wav)

Note:  Audio source files must be sampled at 11.025, 22.05, or 44.1 kHz.
8-bit and 16-bit mono and stereo audio files are supported.
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Synchronized Multimedia

In addition to basic audio and video content, you can create real-time on-
demand multimedia presentations using the RMMerge utility included with
RealEncoder 5.0 and RealPublisher 5.0 (Windows only). These presentations
can be as simple as a narrated slide show of your home page or as intricate as a
multi-frame training program that the viewer controls.

RealNetworks RealAudio and RealVideo have the ability to synchronize World
Wide Web pages with audio and video. Thus, your audio or video clips can be
used as a “time line” to display new pages or frames in the Web browser or to
update its content. This enables the creation of Internet slide shows,
presentations, guided tours and site walk-throughs. A user can have full
random access (fast forward and rewind), and the Web browser content is
synchronized with the audio.

Information about these sycnhronized events is embedded within RealAudio
and RealVideo streams and delivered to a RealPlayer along with the audio and
video data. When this event information is streamed to a RealPlayer, the
RealPlayer in turn sends the location of a desired Web page to a Web browser
telling it to update the page’s content.

Another way to create a synchronized multi-media presentation is using the
RealPlayer plug-in. However, since sending the Web browser to a new URL
unloads the RealPlayer plug-in when the HTML page is unloaded, it is best to
create separate frames for RealPlayer Controls and for the changing images.

Creating a Synchronized Presentation for
RealSystem 5.0

RealEncoder 5.0 and RealPublisher 5.0 allow you to create real time on-
demand multimedia presentations. Creating a synchronized presentation is a
two-step process.
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1. Using a text editor, create an input events file specifying the display time
for each URL, title, author or copyright event. For more details, see the
“Creating an Input Events File” section in this chapter.

2. After creating a text version of the input events file, you must generate an
output presentation file. This is done with the rmmerge.exe tool that
comes with RealEncoder 5.0 and RealPublisher 5.0. To do this, use the
following syntax:

rmmerge -f rmevents <event file> <input media file>
<output media file>

 where:

 event file is the input events file created in the previous step
 input media file is your input .rm file
 output file is the resulting synchronized presentation file

For example:

rmmerge -f rmevents events.txt audio_video.rm
output.rm

Creating a Synchronized Presentation for
RealAudio 3.0 Systems

If you are still using RealAudio Encoder 3.0 to create real time on-demand
multimedia presentations, creating a synchronized presentation is a three-step
process:

1. Using a text editor, create an input events file specifying the display time
for each URL, title, author or copyright event. For more details, see the
“Creating an Input Events File” section above.

2. After creating a text version of the input events file, you must convert the
file to a binary event file. This is done with the cevents32.exe
command line utility that comes with your RealAudio Encoder. To do this,
use the following syntax:

cevents32 <input event file> <output event file>
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where:

<input event file> is the input events text file you just created
<output event file> is the output binary events the file that will be
associated with your encoded audio file.

For example, to a create synchronized multimedia presentation to accompany
paradise.ra, you would generate paradise.rae using the following command:

cevents32 paradise.txt paradise.rae

3. Place the resulting .rae file in the same directory as the .ra audio file.  The
.ra and .rae files must have the same name except for the file extension.
The RealServer automatically detects the file and send the event
information to a RealPlayer, which then sends it a Web browser.

Creating an Input Events File

Begin by creating a list of the URLs, titles, authors, or copyrights that you want
to be shown during your presentation and the times within RealAudio or
RealVideo clip when they should be displayed. The syntax for each entry
should follow the format (with a space between each part of the command):

u starttime endtime EventURL
i starttime endtime Title
a starttime endtime Author
c starttime endtime Copyright

where:

u stands for URL event; each line starts with the letter u
i stands for title; each line starts with the letter i
a stands for author; each line starts with the letter a
c stands for copyright; each line starts with the letter c
starttime is the time into the clip when the new event is shown
endtime is the time into the clip when that event ends
EventURL (generally beginning with “http:” or “file:”) is the Internet
address for that event (usually an HTML document)

The time for starttime and endtime is:

[[[days:]hours:]minutes:]seconds[.tenths]
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The lines of the input file must be in ascending order of start time. The end
time should be at least one tenth of a second before the start time of the next
event. The following example shows how an input file might look:

u 00:00:10.0 00:00:59.9 http://www.real.com/
u 00:01:00.0 00:02:00.0 http://www.mysite.com/ page2/

This input file tells RealPlayer to send the Web browser to the RealNetworks
home page ten seconds into the audio clip. One minute into the audio clip, the
Web browser displays a page from "www.mysite.com".

The input file may also contain comment lines beginning with the # symbol.
These comment lines are ignored by the event creation tool and are a good way
to document the date that the file was created and the type of information found
on each page.

Using Synchronized Multimedia from Local
Files

RealPlayer can also read local synchronized presentation files just as the
RealServer does. In order for the local presentation to work with multiple
platforms and with both Internet Explorer and Netscape Navigator, without
hardcoding the directory structure, you need to follow these steps.

To play a synchronized presentation file locally:

1. Place all .rpm/.ram, .rm, .ra, .rae, HTML and image files in one directory.
The starting document should be named Index.html.

2. Do not use /’s in your file names. Use the following syntax:

u 00:00:10.0 00:00:45.0 &&media&&test2.html

 Note:  You cannot use relative path commands like ../ if you want the
presentation work on a Macintosh.
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Using Synchronized Multimedia with
Bandwidth Negotiation

When you deliver a Synchronized Multimedia presentation using Bandwidth
Negotiation, you can choose to deliver the same event for all encoding formats,
or you can choose to deliver different events for each encoding format.

You can create a single synchronized multimedia presentation for multiple
formats, or you can create a different multimedia presentation for each
encoding format. If you are working with previously created content, you can
continue to use the previous method to create presentations. For new content,
refer to the “Synchronized Multimedia”chapter.

Frames: The Basics

Some Web browsers support a feature which allows the browser window to be
divided into multiple regions. Each region is called a frame and can display a
separate URL such as a graphic or document. For an introduction to frames
visit Netscape’s Web site at:

www.netscape.com

If you are unfamiliar with frames the following two sites provide a good
introduction:

Understanding Frames

www.netscape.com/navigate/understanding_frames.html

Frames: An Introduction

www.netscape.com/assist/net_sites/frames.html
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Editing Audio and Video Files

If you want to edit your audio and video files, you have two options—you can
edit your .rm files, or you can edit your original source files.

Editing the original source files is the editing method of choice. However if you
choose to edit your .rm files, you can use the Windows editing utility,
RMTools, and DOS: RMEdit, RMPaste and RMDump which enable simple
editing of RealVideo files. Encoded video files are stored in indivisible clips of
varying duration depending on the encoding algorithm and the video bit rate.
This limits how precisely encoded video can be cut and pasted.

Editing RealAudio and RealVideo Files

RMTools, the Windows 95 and Windows NT editing utility, is installed with
RealEncoder and RealPublisher. This utility enables you to perform three basic
editing tasks:

• Edit the file properties

• Examine the contents of a file

• Edit the data of a file.
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Editing File Properties

RMTools allows you to edit the static information about the file: title, author,
copyright, and comment as well as the stream name and mime type for each
individual stream. You can also enable or disable Mobile Playback or Selective
Record. Editing the file properties does not affect the data.

To edit file properties of RealAudio and RealVideo files using RMTools:

1. Click Start. From Programs, select Real.

2. Select RealMedia Tools. The RealMedia Tools window appears. Notice
the window is divided into two panes, the source file pane on top and the
destination file pane on the bottom.

3. Select Open Source from the File menu. The Open File dialog box
displays. Select the file you want to edit. The file properties information is
displayed in the source file window.

4. To sort by the stream attribute, click the column. You can also resize the
columns by placing the cursor over the column border and then clicking-
and-dragging.

5. Select File Properties from the Edit menu. The File Properties dialog box
appears. The file name is displayed in the source box and in the destination



RealAudio and RealVideo Content Creation Guide

84

box. New file names can be selected by clicking Browse and selecting a
new file from the dialog box.

6. To save changes to the existing file, do not change the destination file name.
To save the changes to a new file, click Browse to select or enter a different
name in the destination box.

7. Type the new title name, author, copyright information, and any comment
in the appropriate boxes. (You can also type a new title, author, copyright,
or comment directly in the fields on the source and destination panes.)

8. The total number of streams is listed in the Stream Properties box. If you
want to change the name or the mime type of one stream, select the stream
to be changed by clicking the up or down arrow.

9. If you want to change the stream name, type the new name in the Stream
Name box.
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10. Changing the mime type is recommended for advanced users only. If you
are certain you wish to change the mime type, type the new mime type in
the Mime Type box. If you change the mime type, the following warning
will appear after you have applied the changes.

11. Click Mobile Playback if you wish to create content that can be
downloaded by RealPlayers and transferred to Mobile Players such as the
Audible Player for time-shifted playback.

 The Audible Player currently supports the 6.5 Kbps voice codec that is
available as part of the RealEncoder 5.0 and RealPublisher 5.0 products.
Contact your Mobile Playback vendor if you need more information.

12. If you want to allow RealPlayer Plus users to save your clip to disk, click
Selective Record.

13. Click Apply. The changes are applied to the file and displayed in the
source file pane of the RealMedia Tools window.

Examining the Contents of a RealAudio or RealVideo File

RMTools enables you to view the contents of an .rm file by dumping the
contents to a text file. You can then edit or print the file as you would any other
text file.

To examine the contents of a RealAudo or RealVideo file:

1. Select New Session from the File menu.

2. Open the Source file from the File menu. The file information is displayed
in the source pane.
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3. Select Dump from the File menu. The Dump As dialog box appears. The
default name is the same as the source file name, with the extension
changed to .txt. You may also select or enter another dump file name.

4. Click Save. When prompted to view the file now, click Yes.

5. The following error message may appear. If so, click Yes. The Notepad or
WordPad window displays the contents of the file. For an example of an
.rm text file, refer to the “Command Line Editing of RealAudio and
RealVideo Files” section.

6. You can view, edit, and print the file just as you would any other text file.

Editing RealAudio and RealVideo Data

RMTools allows simple editing of .rm files. You can put multiple clips in one
file; you can shorten the length of a clip; and you can take a video stream from
one file and add the audio stream from another file. When working with more
than one file, streams of the same mime type must have the same encoding
parameters if they are going to be pasted together.

To place two RealVideo clips in one file:

1. Select New Session from the File menu.

2. Select Open Source from the File menu. The Open File dialog box appears.
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3. Select the file you want to edit. Click Open. The source file pane displays
the stream number, the stream name, mime type, and the start and end
times.

4. Select Copy from the Edit menu. The Copy dialog box appears.

5. In the Stream Number box, accept the default, All Streams.

6. Do not change the start and end times. Click Copy.

7. Select Paste from the Edit menu. The Paste dialog box appears.
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8. Click Paste. The destination pane displays the stream number, source file,
mime type, start time and end time.

9. Right-click the source pane. A shortcut menu appears. Click Open Source.
Choose a second clip to be added at the end of the first clip. (Both clips
must have the same encoding parameters.)

10. Click Open. The source pane displays the information from the new file
while the destination pane displays the information from the streams that
were previously pasted.

11. Select Copy from the Edit menu.

12. Accept the default, All Streams, and the start and end times. Click Apply.

13. Right-click the destination pane. A shortcut menu appears. Click Paste.
The Paste dialog box appears. The previous end time displays as the new
start time.

14. Click Paste. The second clip is listed below the first clip.

15. If the following warning displays, you must select a different clip or re-
encode the clip so that the encoding parameters are the same.

 

16. Select Save As from the File menu. The Save As dialog box appears.

17. Type the new file name. Click Save.

18. Use RealPlayer to view the new file.
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To put the video stream of one file with the audio stream of another:

1. Select New Session from the File menu.

2. Select Open Source from the File menu. The Open File dialog box appears.

3. Select the first file you want to edit. Click Open. The source file pane
displays the information from the file.

4. Select Copy from the Edit menu. The Copy dialog box appears.

5. In the Stream Number box, select the stream that contains the video. Click
Copy.

6. Select Paste from the Edit menu. The Paste dialog box appears.

7. Click Paste. The destination pane displays the information from the new
file. Notice only the video stream has been pasted into the destination pane.

8. Right-click the source file pane. A shortcut menu appears. Click Open
Source.

9. Choose a second file with the same encoding parameters as the first clip,
and of approximately the same duration. Click Open. The source pane
displays the information from the file.

10. Right-click the source pane. A shortcut menu appears. Click Copy. The
Copy dialog box appears.

11. In the Stream Number box, select the stream that contains the audio. Do
not change the start and end times.

12. Click Copy.

13. Right-click the destination pane. A shortcut menu appears. Click Paste.
The Paste dialog box appears.

14. Click Paste. The audio stream is listed below the video stream. Notice both
streams have the same start time, and should have similar end times.
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15. Select Save As from the File menu. The Save As dialog box appears.

16. Type the new file name. Click Save.

17. Use RealPlayer to view the new file.

Command Line Editing of RealAudio or
Real Video Files

The RealVideo file editing tools, RMCut, RMPaste, RMEdit, and RMDump are
run from a DOS command line. The RMCut tool is used to cut a specific
portion of a RealVideo file without changing the original source. The RMPaste
tool is used to combine two or more RealVideo files. The RMEdit tool is used to
modify the title, author, copyright, comment, mime type, or stream name. It can
also be used to print the current values for the file or stream. The RMDump
tool is used to examine the contents of a RealVideo file.

Editing RealVideo Files

RMEdit has five separate forms. The first form modifies any or all of the title,
author, copyright, and comment for the file.

rmedit -i input -o output [-t title]
[-a author] [-c copyright] [-C comment]

The second form modifies any or all of mime type and stream name for the
selected stream.

rmedit -i input -o output (-S stream number [-m
mimetype] [-s stream name])
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The third form prints out the current values for the file and for each stream that
RMEdit is capable of modifying.

rmedit -i input

The fourth form sets or clears Mobile Playback mode and Selective Record.

rmedit -i input -o output [-r [ON|OFF]] [-p
[ON|OFF]]

The fifth form prints the RMDump version and copyright notice.

rmedit -v

where:

<input> is the path and file name to the input file.
<output> is the path to the output file that contains the edited file.
<title> is the title text.
<author> is the author text.
<copyright> is the copyright text.
<comment> is the comment text.
<stream number> is the stream number for the following two
parameters. (May be repeated for any number of streams.)
<mimetype> is the mimetype for a specified stream.
<stream name> is the stream name for a specified stream.
-v prints the RMDump version and copyright notice.
-k is the mobile playback mode.
-r is the set/clears selective record.

Note:  Only valid mime types (those accepted by the player) should be entered
in the mime type field.

Note Input and output file names must not be the same.

The following examples demonstrate the use of the RMEdit tool:

1. To create a new file modifying the title, enter:

 rmedit -i original.rm -o newfile.rm -t ”My New Title”

2. To change the stream name of stream 1, enter:

 rmedit -i original.rm -o newfile.rm -S1 -s ”New Stream Name”
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3. To display the current contents of the file, enter:

rmedit -i original.rm

Note:  Long file names are acceptable, but file names containing spaces must
be contained in quotes.

Cutting RealAudio or RealVideo Files

Use the RMCut tool to cut a specific portion of a RealAudio or RealVideo file
without modifying the original source. A cut is made by setting the start and
end times for individual streams. Not entering a start time defaults to the
beginning of the file and likewise, not entering an end time defaults to the end
of the file. RMCut can be used without RMPaste to remove the front or end of a
file.

To create a copy of a piece of a RealAudio or RealVideo file:

1. View your original RealAudio or RealVideo file to determine the start and
end times of the segment you want to copy (you can read the times on the
status bar of RealPlayer).

2. Create a copy by typing:

rmcut -i input ([-S stream] [-s start] [-e end]) -o output -v

where:

<input> is the path to the input file
<stream> is the stream number. If not specified, all streams are
used. It can be repeated to grab one or more streams.
<start> is the start time in
Days:Hours:Minutes:Seconds.Milliseconds format. If missing, this
parameter defaults to the beginning of the file.
<end> is the end time in Days:Hours:Minutes:Seconds.Milliseconds
format. If missing, this parameter defaults to the end of the start+input
length. (Multiple start end sequences can be used to cut discontinuous
portions of the stream.)
<output> is the path to the output file that contains the edited file.
-v is the print version and copyright notice

Note:  An image map stream’s start and end times must go from the beginning
to the end of the file. Use RMCut to strip out the image map before working
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with the RealAudio or RealVideo file. Then, to alter and re-merge the image
map file with the video image, refer to the “Image Maps” section in the chapter
“Editing Video Files.”

The following examples demonstrate the use of the RMCut tool.

1. To create a new file with only stream zero, enter:

 rmcut -i source.rm -o cutfile.rm -S0

2. To create a new file with the first 30 seconds of stream 0:

 rmcut -i source.rm -o cutfile.rm -s0.0 -e30.0

3. To create a new file with the first 30 second of stream 0 and with the first
45 seconds of stream 1, enter:

 rmcut -i source.rm -o cutfile.rm -S0 -s0.0 -S1 -s0.0 -e45.0

Examining the Contents of RealAudio or RealVideo Files   

RMDump is used to examine the contents of a RealAudio or RealVideo file.
RMDump accepts two input parameters: the input file and the output file.

To use RMDump, type:

rmdump -i infile -o outfile
rmdump -v

Where:

<infile> is the input .rm extension file
<outfile> is the output text file (use a text editor to view)
<-v> prints the RMDump version and copyright notice.

An example of how to run RMDump is shown below:

Example

>rmdump -i input.rm -o out.txt
dumping input.rm to out.txt . . .
dumping realmedia headers . . .
dumping stream packets
dumping stream 0 . . .
dumping stream 1 . . .
done
! Elapsed time = 556 milliseconds
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The next step is to use an editor like Notepad on Windows NT/95 to examine
the contents of the RMDump.

RealMedia File: input.rm
================
RM_HEADER_OBJECT
... deleted to save space ...
====================
RM_PROPERTIES_OBJECT
... deleted to save space ...
====================
RM_CONTENT_OBJECT
... deleted to save space ...
==========================
RM_MEDIA_PROPERTIES_OBJECT
object_id: 0x4D445052 (RPDM)
size: 155 bytes
object version: 0
stream_number: 0
max_bit_rate: 12062 bps
avg_bit_rate: 12062 bps
max_packet_size: 288 bytes
avg_packet_size: 288 bytes
start time: 0 milliseconds
preroll: 191 milliseconds
duration: 224898 milliseconds
stream_name: The Audio Stream
mime_type: audio/x-pn-realaudio
type_specific_length: 73
==========================
RM_MEDIA_PROPERTIES_OBJECT
object_id: 0x4D445052 (RPDM)
size: 116 bytes
object version: 0
stream_number: 1
max_bit_rate: 7000 bps
avg_bit_rate: 7000 bps
max_packet_size: 668 bytes
avg_packet_size: 564 bytes
start time: 0 milliseconds
preroll: 3474 milliseconds
duration: 228000 milliseconds
stream_name: The Video Stream
mime_type: video/x-pn-realvideo
type_specific_length: 34
====================
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RM_DATA_OBJECT
... deleted to save space ...
==========================
Seek Time: 1 with reqtime = 0 and actualtime = 0
packet 0: stream 0 timestamp 0 size: 288 keyframe
packet 1: stream 1 timestamp 0 size: 639 keyframe
packet 2: stream 1 timestamp 0 size: 619 keyframe
packet 3: stream 1 timestamp 0 size: 599 keyframe
packet 4: stream 1 timestamp 0 size: 544 keyframe
packet 5: stream 1 timestamp 0 size: 639 keyframe
packet 6: stream 0 timestamp 192 size: 288 keyframe
packet 7: stream 0 timestamp 384 size: 288 keyframe
packet 8: stream 0 timestamp 575 size: 288 keyframe
packet 9: stream 0 timestamp 767 size: 288 keyframe
packet 10: stream 0 timestamp 958 size: 288 keyframe
packet 11: stream 0 timestamp 1150 size: 288 keyframe
packet 12: stream 0 timestamp 1341 size: 288 keyframe
packet 13: stream 0 timestamp 1533 size: 288 keyframe
packet 14: stream 0 timestamp 1724 size: 288 keyframe
packet 15: stream 0 timestamp 1916 size: 288 keyframe
packet 16: stream 0 timestamp 2108 size: 288 keyframe
packet 17: stream 0 timestamp 2299 size: 288 keyframe
packet 18: stream 0 timestamp 2491 size: 288 keyframe

The RM_MEDIA_PROPERTIES_OBJECT sections describe the stream type
and stream number for each stream.

- The keyframe field is used to identify the start of a series of related packets.

- Keyframes are sometimes too large to form a single packet. In this case
multiple keyframes will be seen with the same timestamps.

- Some codecs produce packets with the keyframe flag always set. And
others produce a mixture of keyframe and non keyframe packets.

- Packet sizes can be identical in size or vary in size within a single stream.

- The RM_MEDIA_PROPERTIES_OBJECT sections contain attributes of
each stream which include:

1. The stream number.

2. The stream type.

3. The total stream type (audio or video).

4. The total duration of the stream in milliseconds.
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5. The preroll which describes how long to load buffers into the player
before playing the stream.
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Combining RealAudio or RealVideo Files

RMPaste assumes that streams on the input side are joined to streams on the
output side based upon their mime types. Start and End times are specified to
map the input file, which may contain one or more streams, to a new time
range in the output file. Only one file can use default start and end times. Start
and end times must not overlap. If streams overlap, packets from both streams
are intermingled based upon timestamp.

rmpaste (-i <input> [-s <start>] [-e <end>]
[-f <from stream> -t <to stream>]) -o <output> -v

where:

<input> is the path to the input file. There can be one or more -i -s -e
parameters sequences.
<start> is the start time in Days:Hours:Minutes:Seconds.Milliseconds
format. If missing this parameter defaults to the beginning of the file.
<end> is the end time in Days:Hours:Minutes:Seconds.Milliseconds
format. If missing this parameter defaults to start+input length.
<output> is the path to the output file that contains the edited file.
<from stream> is the input stream number to be sent to the to stream.
<to stream> is the output stream number.
-v is the print version and copyright notice.

Note RMPaste can paste in additional streams and add to existing streams.
When streams are pasted together, the timestamps must not overlap.

Note If multiple streams are in the input file and the timestamps of the
streams do not start at the same time, the start time applies to the earliest
stream in the file. The start time plus the difference between the streams first
packet is used for the remaining streams. See first example.

The following examples demonstrate the use of the RMPaste tool:

1. If you cut three streams from a source file using:

rmcut -i source.rm -o cutfile1.rm -S0 -s10.0 -S1 -s20.0 -S2 -s30.0
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resulting in an output file like:

Times

Stream0: 0.3 1.1 ….

Stream1: 10.4 12.4 ….

Stream2: 22.0 32.0 ....

and mapped it using:

rmpaste -i cutfile1.rm -s5.0 -i cutfile2.rm -e5.0 -o paste.rm

the new stream times for cutfile1.rm would be:

Times

Stream0: 5.3 6.1 ….

Stream1: 15.4 17.4 ….

Stream2: 27.0 37.0 ....

with cutfile2.rm placed from the beginning of the file to 5 seconds into the
file. (packets not shown)

2. To create a new file using the first 60 seconds of the source.rm file
swapping the first 45 seconds with the next 15 seconds in the file enter:

rmcut -i source.rm -o cutfile1.rm -s0.0 -e45.0
rmcut -i source.rm -o cutfile2.rm -s45.0 -e60.0
rmpaste -o newfile.rm -I cutfile2.rm -s0.0 -e15.0 -I cutfile1.rm -s15.0 -
e60.0

3. To add a new stream to an existing file:

rmpaste -I original.rm -I newstream.rm -o newfile.rm
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Image Maps

"Click-able" image maps allow users to interact with the video content by
adding image-specific video seeking and URL commands. Image maps are fully
customizable; actions can be connected to rectangular, circular or polygonal
content regions and can be varied over specific user-defined time intervals.

To create Image Maps:

1. Create an Image Map File (text file).

2. Merge the Image Map file (with a .rm file).

Creating an Image Map File

Image Map Files are text files that have HTML-like tags which specify the
location and action of each image map. Image map files should be created in a
text editor and saved as text only.

All tags shown below are required unless otherwise stated. Negative values for
numbers are not allowed.

DURATION Tag

This tag must be at the beginning of the file. The DURATION tag specifies the
amount of time from the start time of the first map to the end time of the last
map in the file. The format is as follows:

DURATION=x:x:x:x:x

Tag Name Description

DURATION Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the
these fields must be present. That means if you don't
want to specify a particular setting, fill 0's in that space.
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MAP Tag

This line describes the overall properties of the image map. You may have as
many MAP tags in a file as you wish. The format is as follows:

<MAP START=x:x:x:x:x END=x:x:x:x:x COORDS=x,y,x1,y1>

Tag Name Description

START Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields
must be present. That means if you don't want to specify a particular
setting, fill 0's in that space. If START contains all 0's then the start
of the clip is assumed.

END Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields
must be present. That means if you don't want to specify a particular
setting, fill 0's in that space. If END contains all 0's then the end of
clip is assumed.

COORDS Specifies the rectangle that this entire map is going to occupy. If you
enter an area bigger than the entire display area, the entire area is
active. Any area not located within this rectangle will be clipped.

Note:  Using the /MAP tag means you are done with the current image map.

AREA Tag

There can be 0 to 40 area lines in an image map. These lines describe the
different regions that are active within an image map.

<AREA START=x:x:x:x:x END=x:x:x:x:x SHAPE=XXXX
COORDS=x0,y0,x1,y1,x2,y2,…xn,yn action_tag ALT="" >
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Tag Name Description

START Specifies the start time of this area during the map. This field is
optional; if you do not include a START time, the area begins at the
beginning of the map time. Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must
be present. That means if you don't want to specify a particular setting,
fill 0's in that space. If START contains all 0's then the start of the
current map is assumed.

END Specifies the end time of this area during the map. This field is
optional; if you do not include an END time, the area ends at the end of
the map time. Times are specified in the following format:
Days:Hours:Minutes:Seconds:MilliSeconds. All of the these fields must
be present. That means if you don't want to specify a particular setting,
fill 0's in that space. If END contains all 0's then the end of map is
assumed.

Note If the start and end times of an area are outside the start and end
times of the map, then the start and end times of the map are used.

SHAPE The XXXX for the SHAPE tag can be one of the following values:
(CIRCLE, RECTANGLE, POLYGON).

CIRCLE - COORDS tag should specify three values:
centerX,centerY,radius

RECTANGLE - COORDs tag should specify four values:
left,top,right,bottom

POLYGON - COORDs tag should specify at least 6 values (x and y
coordinates for at least 3 points). These are the vertices for the
polygon.

action_tag The action_tag is one of the following: PLAYER, URL, SEEK.

PLAYER - Used to specify a new stream to play with RealPlayer. For
example:

PLAYER="pnm://video.real.com/welcome.rm"

URL - Used to specify a new URL to display in a browser. For
example:

URL="http://www.real.com"

SEEK - Used to specify a time within the current clip to seek to. For
example:

SEEK=0:0:0:5:0.

Note the format is just like the START and END tags.

ALT The ALT tag contains text that appears in the status bar of the
player when the mouse is over this AREA and it is active. If you
want no text then use "" as shown above.
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Image Map Example
DURATION=0:0:0:40:0

<MAP START=0:0:0:0:0 END=0:0:0:5:20 COORDS=0,0,100,100>

<AREA SHAPE=CIRCLE COORDS=50,50,10
URL="http://www.real.com" ALT="Home Page">

</MAP>

<MAP START=0:0:0:5:20 END=0:0:0:20:3 COORDS=0,0,100,100>

<AREA SHAPE=RECTANGLE COORDS=0,0,50,50 SEEK=0:0:0:3:98
ALT="Seek to a point in the clip">

</MAP>

<MAP START=0:0:0:20:3 END=0:0:0:40:0 COORDS=0,0,100,100>

<AREA END=0:0:0:30:0 SHAPE=POLYGON COORDS=0,50,50,0,100,50
PLAYER="pnm://video.real.com/welcome.rm" ALT="">

<AREA START=0:0:0:31:0 SHAPE=POLYGON
COORDS=0,25,25,0,100,50 SEEK=0:0:0:0:0 ALT=”Rewind to
Beginning”>

</MAP>

Merging an Image Map File with a Video Image

When you have finished creating the Image Map file, you convert the Image
Map text file into a .rm file using the RMMerge tool that is installed with
RealEncoder and RealPublisher . Then, you merge that .rm file with an
encoded video (.rm) file.

To convert the Image Map file into a .rm file:

1. From a DOS command line, change directories to the directory that
RealEncoder or RealPublisher was installed, which by default is
C:\REAL\RVENCODE

2. Enter the following command:

rmmerge -f rmimap.dll image_map_text image_map_rm
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 Done..... appears when the image map text file has been converted to a .rm
file.

 Note:  If you receive the message Error Parsing file, verify that the Image
Map file is saved as text only and the tags are used correctly.

3. Merge the Image Map .rm file with a video (.rm) file by typing the
following command:

rmmerge image_map_rm video_rm final_rm

 The final_rm file contains your Image Map as well as the audio/video clip.

4. Verify the Image Map by playing the final_rm file with RealPlayer.

Modifying RealAudio and RealVideo File
Descriptions

You can change the Title, Author, or Copyright text, and modify the Selective
Record and Mobile Playback settings in a .rm file using several different
methods:

Method Description

RMTools The is the editing tool available for Windows 95 and
Windows NT.

Refer to the“Editing File Properties” section.

RMEdit Tool This is a command line tool available for Windows.

Refer to the “Command Line Editing of RealVideo
Files” section.

.ram File Set the Title, Author, and Copyright text strings in
the .ram file.

Refer to the “Metafiles”section of the “Configuring
Your Web Site” chapter.
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Advanced Editing

For advanced editing of RealAudio and RealVideo, the following programs are
recommended:

• Adobe Premiere

• In sync Kohesion
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Publishing to the Web

RealPublisher is an enhanced version of RealEncoder and offers Web
publishing features including:

• automatic HTML page creation

• easy uploading of HTML pages to either a standard HTTP Web server or a
RealNetworks RealServer

Creating Web Pages (HTML)

A primary feature of RealPublisher is the HTML Generation Wizard. With it
you can automatically create an HTML page that contains your encoded media
file and play back the media file through your Web browser.

The wizard leads you a series of prompts to help you create the HTML file and
choose how your Web page will look displayed either with a Pop-up Real Player
Embedded RealPlayer. The wizard then allows you to preview the finished
page.

The Pop-up RealPlayer  application is launched and run from the browser and
uses a standard display window and controls. The Embedded RealPlayer is a
Netscape or Active X plug-in that allows you to integrate components of
RealPlayer within your Web page. With it you can also customize the controls
and design of your Web page.

To create a Web page displaying a pop-up RealPlayer (single audio or video data
rate file):

1. Start RealPublisher. The RealPublisher window opens.

2. Click Create HTML. The HTML Generation Wizard window appears.

3. Click Next to select a media file. The Media File page appears.
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4. Click Encoded File.

5. If you are creating a Web page for bandwidth negotiated files click
Bandwidth Negotiation.

6. The name of the last file encoded appears by default: If you wish to use the
default file, click Next.

7. To select the name of a different file, click Browse. The Select File dialog
box appears. Select the file and click Open.

8. The Playback Method page appears. Click Next.

9. Click Pop-Up Player and  click Next.

10. The RealMedia caption name page appears. This name is what viewers
will will use to select this content.

11. Enter caption name and click Next.

12. The Filename page appears. Enter name of HTML file you want to create
and click Next.

13. If you wish to preview your HTML page with a Web browser, click
Preview HTML on the Results page.

14. When preview is completed, click Finish.

To create a Web page displaying an embedded RealPlayer (single audio or video
data rate file):  (single audio or video data rate file):

1. Follow steps 1-6 for displaying pop-up RealPlayer.

2. Click Embedded RealPlayer and click Next.

3. The Player Control page appears. Select player control layout from the
available templates. Click Next.

4. Select player control layout from the available templates and click Next.

5. Click Auto Start if you wish the RealAudio or RealVideo file to
automatically launch when Web page is displayed.
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6. The RealMedia caption appears. This name is that viewers will use to
select this content.

7. Enter caption name and select caption placement by clicking Place
Caption Above Embedded Player button or Place Caption Below
Embedded Player button. Click Next.

8. The Filename page appears. Enter name of HTML file you want to create
and click Next.

9. If you wish to preview your HTML page with a Web browser, click
Preview HTML on the Results page.

10. When preview is completed, click Finish.

Note:  Keep in mind that the web pages you create with the HTML wizard will
initially point to media files located on your local hard drive. When you upload
your pages to a remote web server, these local file references will automatically
be updated. You should avoid making manual changes to any HTML files
created by the HTML wizard. Alterations to these files or any file references
contained in the associated .ram/.rpm metafile may cause errors when
publishing Web pages to a remote server.

Automatic Creation of Metafiles

A metafile connects a Web page to one or more RealAudio or RealVideo clips
located on a remote server. The function of a metafile is to “point” to the
location where your media file actually resides and is required for your file to
“stream”, not just download and play.  Typically, a metafile is located on the
Web server and contains the URL where your RealAudio or RealVideo clips
can be found. Metafiles are automatically created and updated by RealPublisher
during the Web page creation and publishing steps.

Metafiles created by the RealPublisher during the “Create HTML” process
reside on your local hard drive and point to files on your local file system.
When you publish with the RealPublisher, they are automatically updated to the
servers where your media files are sent.
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Publishing Your Files

Another primary feature of RealPublisher is the Publish-to-Server Wizard. It
allows users to publish their RealAudio and RealVideo-enabled Web page to a
remote server. The server can be either a RealNetworks RealServer or a
standard HTTP Web server using a standard FTP protocol.

The wizard leads you through a series of prompts to help you specify the type of
server and the directory where you will upload your page. You can also specify
the name of the Web server and the URL path where your Web page will be
located. The wizard then allows you to preview the finished page.

Remember that when you upload your Web pages to a remote server,
RealPublisher automatically updates your HTML and .ram/.rpm metafile to
point to the appropriate server addresses, directories and files.

To avoid confusion during the publishing process, two worksheets have been
provided for you below: one for simple HTTP streaming and the other for
streaming your media files from a RealServer. It is recommended you complete
the appropriate worksheet before you begin.
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Worksheet 1:
Publishing a File to Stream from an HTTP Web Server

If you are using a standard HTTP Web server to stream RealAudio or
RealVideo, you should obtain the following information from your system
administrator or ISP. For simple HTTP streaming, your Web page and media
file will be copied to the same location.

1.  File Server: Name or IP address of the file server that your Web page will
be uploaded to.  For example: ftp.server.com.
___________________________

2.  Directory: Name of the directory on the file server where your Web page
will be uploaded to. For example, if the personal directory assigned to you by
your system administrator is ‘htmlpages’, enter htmlpages as the directory
name. Note:  The directory field is optional and may be left blank. This is
because on certain servers you may be automatically placed in your personal
directory when you log in. __________________________________________________

3.  Web Server: Name or IP address of the Web server users will use to locate
your Web page.  For example, if the full URL users will use is
http://www.server.com/htmlpages/file.htm, enter www.server.com as the
Web server name. _______________________________________________

4.  URL Path: The URL path on the Web server that users will use to locate
your Web page.  For example, if the full URL is
http://www.server.com/htmlpages/file.htm, enter htmlpages as the URL
path.
______________________________________________________________
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Worksheet 2:
Publishing a File to Stream Directly from a Real Server

If you are using a RealServer to stream RealAudio or RealVideo, you will need
to obtain the following information from your system administration or ISP.
Please note that for streaming from a RealServer your Web page will be copied
to a standard HTTP Web server, while your encoded media file may be copied
to a separate RealServer.

1.  File Server: Name or IP address of the file server that your Web page will
be uploaded to.  For example: ftp.server.com.
____________________________

2.  Directory: Name of the directory on the file server where your Web page
will be uploaded to. For example, if the personal directory assigned to you by
your system administrator is ‘htmlpages’, you would enter htmlpages as the
directory name. Note:  The directory field is optional and may be left blank.
This is because on certain servers, you may already be put in your personal
directory when you log in.
_________________________________________________

3.  RealServer: Name or IP address of the RealServer that your encoded
media file will be uploaded to.  For example: ftp.server.com.  _____________

4. Media Directory: Name of the media directory on the RealServer where
your encoded media file will be uploaded to.  For example, if the media
directory assigned to you by your system administrator is ‘myvideo’, you would
enter myvideo as the directory name. _________________________________

5.  RealServer Location: Name or IP address of the RealServer that users will
use to locate your media file. For example, if the full URL users will use to
locate your media file on the Internet is
pnm://pnm.server.com/myvideo/file.rm you would enter pnm.server.com as
the RealServer name.  _____________________________________________

4.  URL Path: The URL path on the RealServer that users will use to locate
your media file. For example if the full URL that users will use to locate your
media file is pnm://pnm.server.com/myvideo/file.rm you would enter
myvideo as the URL path. _________________________________________
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The following Web page publishing instructions (both standard HTTP Web
server and RealServer) are for users who selected the Generic - No Defaults
setting when installing RealPublisher. Otherwise, if you selected a specific
Internet Service Provider from the listbox during installation, you should follow
the simple steps provided by the online wizard.  The wizard will automatically
appear after completing step one below.

To publish a file to stream directly from a standard HTTP Web server:

1. Click Publish. The Publish to Server Wizard window appears.

2. Click Next to create a wizard. File Name page appears with the name of
the last Web page created using the wizard:

3. Click Next if you wish to publish this page.

4. Click Browse to select another file. Select File page appears. Enter name
of file you wish to publish and click Open.

5. The Service Provider page appears. Choose an Internet Service Provider
from the list or select Generic - No Defaults if your Service Provider is not
listed.  Click Next.

6. The Streaming Method page appears. Click Stream Media File from a
Standard HTTP Web Server and click Next.

7. The Web Server Information Upload Location page appears. Type in the
name or IP address of the remote  server where you are uploading your
files and the directory on the upload server where your page will be
sent.Then type in your user name and password.

8. The Web Server Information Internet Location page appears. Type in the
name or IP address of the Web server and URL path that users will use to
locate your Web page on the Internet.

9. Please note that the Upload Location may be different than the one used to
view your Web page on the Internet. Contact your Internet service provider
for this information.

10. The Upload Progress page appears. Click Finish. Your files automatically
upload to your Web server.
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To publish a file to stream directly from a RealServer streaming media server:

1. Click Publish. The Publish-to-Server Wizard window appears.

2. Click Next to create a wizard. File Name page appears with the name of
the last Web page created using the wizard:

3. Click Next if you wish to publish this page.

4. Click Browse to select another file. The Select File page appears. Enter
name of file you wish to publish and click Open.

5. The Service Provider page appears. Choose an Internet Service Provider
from the list or select Generic - No Defaults if your Service Provider is not
listed.  Click Next.

6. The Streaming Method page appears. Click Stream Media File from a
RealServer, then click Next.

7. The Web Server Information Upload Location page appears. Type in the
name or IP address of the Web server where you are uploading your files
and the directory in the upload server where your page will be sent. Then
type in your user name and password.

8. The RealServer Information Upload Location page appears. Enter the
name or IP address of the RealServer where your media file will be sent.
Enter the directory where your media file will be sent and click Next.

9. The RealServer Information  Internet Location page appears. Type in the
name or IP address of the RealServer and URL path that users will use to
locate your media file on the Internet.

 Please note that the Upload Location may be different than the one used to
view your media file on the Internet. Contact your Internet service provider
for this information.The Upload Progress page appears.

10. Click Finish. Your files automatically upload to your Web server.
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Broadcasting Live Content

RealEncoder or RealPublisher included with a RealNetworks RealServer can
deliver live content for broadcasting live events.

To deliver live content, you need:

• A live source

• A computer running RealAudio Encoder 3.0, RealEncoder 5.0 or
RealPublisher 5.0

• A machine running a RealNetworks RealServer with a minimum of  60-
streams

• RealPlayer

The computer running the encoder and the computer running RealServer can
be on different platforms. Also, RealEncoder 5.0 and RealPublisher 5.0 require
RealServer 5.0.

If you choose, you can save the event to disk while you are broadcasting. For
more information about this, see the “Archiving Live Broadcasts” later in this
chapter.
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To provide content in multiple compression algorithms, you need to run a
RealEncoder or RealPubliserh and a separate computer for each codec, all with
the same input signal. All concurrently running RealEncoders or
RealPublishers should use identical settings except for compression type and
stream name. Each computer sends its output to a RealServer.

For example, here are three different templates you might use simultaneously
for live content (use the diagram above for reference):

• Video 28.8 Talking Heads

• Video 56.6 Dial-Up Modem, Voice

• Video High-Bite Rate 100K, Voice

Be sure each file on each computer has a different name, such as
mediafile_28.8.rm, mediafile_56.6, and mediafile_100.rm.  The file name
should be easy to identify, because RealPlayer users will have to choose the
appropriate file based on their particular modem connection. We recommend
including the modem bandwidth connection in the name to help the user
choose correctly.

Encoder 3
Workstation 3

Video High-Bite
100K Voice

Encoder 2
Workstation 2

Video 56.6, Dial Up
Voice

Encoder 1
Workstation 1

Video 28.8
Talking Head

Real Server

mediafile_28.8.rm

mediafile_56.6.rm

mediafile_100.rm

Live
Source

RealPlayer
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Note:  Bandwidth negotiation during live events is not supported by
RealEncoder 5.0, RealPublisher 5.0 or RealServer 5.0.

Designing Live Encoding Templates

Live encoding usually requires creating your own template. How you design
your template depends largely on the power of your system. When encoding
video frames that are 176 x 128 pixels, a 200 MHz Pentium computer gives a
good result with a frame rate of 4 to 15 fps.  A Dual Pentium 2 gives the best
results for high frame rates and large screen sizes. See the “System
Requirements” chapter for more information.

Delivering Live Content with RealServer

To deliver live content:

1. Attach your audio or video source to the audio or video capture card.

2. Configure the server.cfg file. For more information on how to configure
this file, see the RealServer Administration Guide.

 Be sure the following configuration settings are included in the RealServer
configuration file:

• PnaPort - the port number to which the Encoder connects.

• EncoderPassword - the password the Encoder uses to connect.

• Encoder Timeout - configuration parameter specifies how long RealServer
stays connected to a RealEncoder/RealPublisher that is not sending data.

• LiveFileTarget and LiveFilePassword - (Optional) Specify that the server
saves the live content as a file.

3. Configure RealEncoder or RealPublisher for live broadcasting and click
Start to begin encoding.
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Connecting RealEncoder or RealPublisher to RealServer

RealEncoder and RealPublisher translates the broadcast into one or more
formats that RealServer can distribute over the Internet. As administrator of the
RealServer , you must provide a way for the RealEncoder or RealPublisher to
connect to RealServer. You do this using the PnaPort and EncoderPassword
configuration settings on the RealServer.

The EncoderPassword setting specifies the password the Encoder must use to
connect to RealServer. Passwords are necessary to keep unauthorized users
from connecting to the stream of your live broadcast. For example, if you have
the setting:

EncoderPassword FrogNet

the person starting the Encoder must use the password FrogNet to start the
Encoder.

EncoderPassword

Password used by RealAudio Encoder, RealEncoder or RealPublisher and the
rvslta utility program to connect to RealServer.

Used by pnserver

Default value (none)

Range of values Alpha-numeric string without
spaces

Restart Server after change No

EncoderPassword <password>

Note that the default setting of no password allows any RealAudio Encoder,
RealEncoder, or RealPublisher to connect to the server.

Example

EncoderPassword rmRecord1
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EncoderTimeout

The time in seconds that the Server will wait before disconnecting
RealEncoder/RealPublisher that is not sending data. If the connection to
RealEncoder/RealPublisher is lost, the Server must disconnect before
RealEncoder/RealPublisher can reconnect.

Used by pnserver

Default value 30

Range of values 1 - 32767 seconds

Restart Server after change No

EncoderTimeout <seconds>

Setting EncoderTimeout to less than 10 seconds is not recommended.

Example

EncoderTimeout 20
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EncoderControlList

Allows multiple people to encode live content and use the same file name for
different files. The file is published to a virtual directory beginning with the
user’s name.

Default value (none)

Range of values Alpha-numeric string without spaces

Syntax

 EncoderControlList [ {user1, user1password},
{user2, user2password}, ...]

Example

 EncoderControlList [ {smith, encd} ]

In this example, any files encoded by the user “smith” will appear in a virtual
directory named “smith.” So if the user encodes a file and calls it “live.rm,” the
path to file will be “pnm://my.server.com/content/smith/live.rm”.

Live Broadcast System Requirements

Delivering live video content at a higher frame rate requires a different system
configuration that delivering live content at a low frame rate. Three
recommended configurations are detailed below.
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Configuration 1: Low Frame Rate (<2 frames per second)

Source Feed
Any video
source with
S-video or
composite
output

Encoding Station
• Pentium 166 or

greater
• VFW-capable

capture card
• Windows 95
• Sound card
• RealPublisher or

RealEncoder

RealServer
Any
RealPublisher
or RealEncoder
supported
platform

S-Video (preferred)
or Composite

Point-to-Point IP Connection
(Internet not recommended)

Internet Connection

Configuration 2: High frame rate (up to 10 frames per second* <200 streams)

Source Feed
Any video source
with S-video or
composite output

Encoding Station and
RealServer

• Pentium 200 Pro
• VFW capture card
• Windows NT
• Sound card
• RealPublisher
• RealServer

S-video (preferred)
or composite Internet Connection

*Actual maximum frame rate is dependent on bit rate and content.

Configuration 3: High frame rate (up to 15 frames per second)

Source Feed
Any video
source with S-
video or
composite
output

Encoding Station
• Dual Pentium 200 or

greater
• VFW-capable capture

card with NT drivers
• Windows NT
• Sound Card
• RealPublisher
 or RealEncoder
• RealServer

RealServer
Any RealServer
supported
platform

S-video (preferred)
or composite

Point-to-Point IP connections
(Internet not recommended)

Internet Connection
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Encoding Live Content for Windows

There are a variety of techniques you can use to improve the quality of your live
content. These include changing variables such as frame rates, frame size,
audio codecs and total bit rate.  It also includes monitoring your output to
ensure you are delivering content with the highest possible quality.

Producing High Quality Live Content

• The average bit rate should be equal to the requested bit rate (the bit rate
specified in the template). If the average bit rate exceeds the requested bit
rate, you can:

1. Switch to Optimized Frame Rate.

2. Use a lower bit rate audio codec.

3. Use a higher requested bit rate.

• Audio quality is important when delivering live content. Setting the
volume too low can result in a weak signal. Setting the volume too high
can cause a distortion of the audio.

• Latency, the amount of time required for buffering the video, should not
exceed 5-10 seconds when delivering live content.

• View the live content using a RealPlayer. This allows you to see how the
live content looks when it is delivered.

• If you are not maintaining the required frame rate, reduce the system load
by disabling the encoder preview window. If you are having encoding
problems you have four variables to adjust:

1. Frame size

2. Frame rate selection

3. Total bit rate

4. Audio codec (portion of total bits)
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You may need to experiment with these variables to achieve the overall
effect you are after.

Live Encoding RealAudio or RealVideo

To encode and broadcast live audio or video using RealEncoder or RealPublisher:

1. Start RealEncoder or RealPublisher.  The RealEncoder or RealPublisher
window opens.

2. Click Open Session from the File menu. The Open Session window
appears.

3. In the source pane, verify that Capture Device is selected.

4. Click Audio Capture for audio only or select Audio Capture and Video
Capture for video with audio.

5. In the destination pane, click RealServer.

6. While performing a live broadcast you can archive the event by also
selecting Destination RealMedia File from the Open Session window.

7. Enter host name, which is the domain name or the IP address of the
RealNetworks RealServer computer.

8. Enter your password. This field is optional depending on how your
RealServers set up.

 Due to security enhancements to RealServer 5.0, RealEncoder and
RealPublisher 5.0 can only encode live streams to RealServer 5.0.
Encoding live streams to RealServer 4.0 will return the following message:
“Server Alert: Invalid Password.”

9. Enter the resource name, which is the name you give to the audio or video
stream being encoded and which users will refer to.

10. Click OK. The Open Session window closes.

11. In the properties pane, enter the Title, Author, and Copyright information
for your output stream. These fields are optional. If you choose to provide
this information, it will be displayed on the viewer’s Real Player.
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12. To allow RealPlayer Plus users to save your  Real Audio or RealVideo
signal to disk, click Selective Record.

13. In the templates pane, select the template to encode the file.

14. Select Statistics from the View menu. The Statistics window appears. The
information displayed in this window during broadcast will help you
evaluate and adjust your template settings.

15. The audio level meter, view input video window and view output window
can be turned off to marginally increase performance. From the Options
menu, click Show Source Input, Show Encoded Output, and Show
Audio Meter  to clear the selection.

16. For video encoding only, notice Frame Rate in the results pane of the
Statistics window. Wait while enough data is collected for an average
frame rate to be determined. If the average frame rate is below the frame
rate set in your template, adjust the encoding by varying one of the five
variables.

17. For video encoding only, notice Latency in the results pane of the
Statistics window. If latency is greater than 5 or 10 seconds, adjust the
template.
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For video encoding only, select Set Video Format from the Options menu.
You can use this option to adjust video format settings while delivering
live content. Click OK to accept the current settings.

18. Click Start and monitor the progress of the encoding.

 Note:  Listening and viewing the live content through your Web browser is
strongly recommended.

Live CommandLine Encoding for Windows

Command line options allow automation of live feeds. Refer to the “Command
Line Encoding for Windows” section of the “Using RealEncoder and
RealPublisher” chapter for a list of static encoding options. Additional
RealEncoder/RealPublisher options for live encoding are listed below:
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Command Line Options for Live Feed Automation

Option Description

/L Turns on Live Input instead of static input
file. The destination can then be selected
between server or file output.

/S server[:port]/filename Specifies delivery to a server on the
supplied port. If the port is not supplied
then the default of 7070 is used. The server
can be either a hostname or IP address. The
filename is used as the target on the server.

/W password Specifies the password, if required to
connect to the Live Server. The default is
no password and is only used if the target is
a server.

/O Used for the file name at the encoder if
simultaneous file output is required.

/I Specifies an Input File.

/D hhh:mm:ss Allows encoder to run for the supplied
time. The maximum time is 999:59:59.
When the time elapses then the encoder
should gracefully shutdown and exit. If a
static file is being encoded and the file ends
before the maximum duration, there is no
need for an error message. If this option is
not supplied, then the encoder continues to
run.

Ctrl-C Terminates encoding.

Enhancing Live Broadcasts with Video Image Maps and
Synchronized Web Pages

You can deliver a Synchronized Multimedia presentation or apply an image
map to a video stream with a live broadcast. The events are delivered relative to
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the time a client begins playing the live broadcast, instead of relative to an
absolute position in the broadcast.

The URL events must be defined before the broadcast, but you can change the
content of the Web page the URL references during the broadcast.

An image map can change over time, but this is not synchronized with the
video stream. You can add any static content type to a live stream that is not
already present in the stream. An example of this could be a link for the whole
image to a site with a link to the broadcaster tied to a superimposed logo added
to the stream before encoding.

To create a Synchronized Multimedia presentation for a live broadcast:

1. Create the input file that defines each event and the time that the event is
sent. Remember that the times you specify are relative to when the client
begins playing the live broadcast.

2. Run the rmmerge tool to create a .rm file.

3. Repeat steps 1 and 2 for any image maps.

4. Name the .rm file with the same filename you specify in the Resource box
in RealPublisher or RealEncoder  for the broadcast.

5. Move the .rm file to the path specified in the Resource box in
RealPublisher or RealEncoder .
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 The following example shows RealPublisher screens. RealEncoder
procedures are similar:

 

For example, if you set up RealPublisher as follows, the file must be named
concert.rm and it must be located in the /live directory relative to the
server’s base path.

Archiving Live Broadcasts

You can choose to save (or “archive”) a live broadcast for playback later.
RealServer can be configured to automatically archive live broadcasts or you
can use the rafile or rmfile utility program to archive broadcasts from any
RealServer over a network. You can choose to create just one file, a new file
based on elapsed time such as every 30 minutes, or a new file based on size
such as every 5 MB. Rafile archives audio-only broadcasts; rmfile archives
video-only or audio-and-video broadcasts.

If RealServer or rafile or rmfile archives a live broadcast with the same
destination path and file name used for a previous broadcast, the .rm file from
the previous broadcast is overwritten. Reusing the same output file name can
simplify Web page maintenance, because the links for a recurring event remain
the same. If you want to maintain an archive of live broadcasts, either copy the
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.rm file elsewhere before it is overwritten or use unique file names for each live
broadcast.

Rmfile can be driven either by command line options or by a configuration file.
The command line options will always overrule the configuration file.

 To configure RealServer to archive automatically:

If you specify the LiveFileTarget and LiveFilePassword settings in the
server’s configuration file, RealServer automatically archives any live media
stream that arrives at the Server. These media streams are created as
RealMedia (.rm) files. Be sure you have enough available disk space to store
the files generated from a live broadcast. The archive files are stored in the
directory specified by the LiveFileTarget setting, or in the working directory
that was used to start RealServer if a target directory is not specified.

 To configure RealServer to save manually:

The rafile and rmfile programs can run on a different computer than
RealServer or RealEncoder/RealPublisher because they accept a network
address for the media source. Archive files written by rafile or rmfile are
stored in the directory specified, or in the working directory used to start the
rafile or rmfile program if no directory is specified.

For a list of options for the rmfile program, at a command line, type:
 

 rmfile /?

 

Example 1:

A television station broadcasts over the Internet and wants to archive the entire
broadcast day in multiple files each 60 minutes long to the /usr/Archive
directory. The broadcast is named Live.rm and is available in RealVidep 28.8
format only. The relevant configuration settings are:

LiveFilePassword   rmBroadcast1
LiveFileTarget   /usr/Archive
LiveFileTime   1h

RealServer automatically archives the live broadcast to a series of files named
Live0.rm, Live1.rm, Live2.rm, and so on, in the /usr/Archive directory. Each
file contains one hour of audio data encoded in the RealVideo 28.8 format.
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Example 2:

A concert promoter broadcasts a live concert over the Internet and wants to
archive the entire concert on a separate computer. The archive computer runs
the rmfile utility program from a command line.

The configuration file setting on the RealServer computer is:

 LiveFilePassword rmBroadcastZ

The command on the archive computer is:

 rmfile -b -p rmBroadcastZ
pnm://my.server.com:7070/live.rm
c:\real\server\content\archive

The rmfile utility program connects to the server using the URL
pnm://my.server.com/live.ra. The resulting files can be copied to a RealServer
for later rebroadcast of the concert.

Simulating a Live Broadcast

At times, you might want to play a recorded media file as if it were being
broadcast live. Perhaps you want to test your system before a live event or delay
broadcast of a concert. The rvslta (RealVideo Simulated Live Transfer Agent)
utility lets you play a recorded media file as if it were live.



RealAudio and RealVideo Content Creation Guide

130

To use rvslta, you need to specify the password from the Server’s
EncoderPassword configuration setting (in the RealServer configuration file)
and the names of the input and output files.

The rvslta (RealVideo Simulated Live Transfer Agent) utility delivers pre-
recorded content as if it were a live event. Users connecting to the link will get
the event “in progress”. It can be used as a test, to delay broadcast of a live
event or to multicast pre-recorded content.  The syntax is as follows:

Syntax

rvslta -i <inputfile.rm> -o <outputfile.rm> -s <server> [-p <port>] [-w
<password>]
[-l <iterations>]

where:

<inputfile> is the path and file name to the input file.
<outputfile> is the path and file name to the output file.
<server> is the server name.
<port> is the server port (port defaults to 7070).
<password> specifies the password rvslta uses to connect to the server.
It matches the password specified by the EncoderPassword in the
configuration settings file.
<iterations> is an integer.

Example

 rvslta -i c:\archive.rm -o livenow.rm -s
www.my.server.com -p 7070 -w rmRecord1
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Advertising Live Events

With a RealNetworks RealServer, you can send live events directly to user’s
computers, letting people enjoy music, speeches, and public events from their
computers. Whether you are promoting a concert, holding a company meeting,
or covering a campaign speech, you can use RealAudio and RealVideo to
attract whole new audiences.

If you want help advertising your site or live event, you can advertise in
“Timecast: Your RealMedia Guide” (http://www.timecast.com), the
RealNetworks online resource for RealAudio and RealVideo sites and live
events.

Inform the Timecast staff of your site or event by completing an online form.
After you submit the online form, the data is verified by a staff member of
Timecast and posted on the Timecast site. Timecast strives to be a quality
listing service and therefore maintains editorial control over all information
submitted. If you have any questions or need to make changes to any
submissions please email Timecast@Timecast.com.

To advertise your site on Timecast:

Use the Web form located at  http://cgi2.timecast.com/cgi-bin/addsite.cgi to
submit your newly completed site for inclusion in either Timecast’s Audio,
Video, or Live Stations Guide. On the Web form, you enter basic information
about the site such as the site name, URL, and description.

To advertise your event on Timecast:

Use the Web form located at http://cgi2.timecast.com/cgi-bin/addlive.cgi to
submit all your live events. On the Web form, you enter basic information about
the event, such as name, complete URL, date and time of the event, and a short
description. You can also indicate whether the event is recurring (occurs
weekly) or non-recurring (one-time only).
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Place Special Tags in your HTML Code

If you have several different events, you can save time by inserting special “live
tags” in your HTML code. The live tags are placed within comment lines in the
source html, so that they are invisible to your users. A software robot reads the
information in the live tags and automatically enters the event(s) in Timecast.

To advertise your live event using special tags:

1. On the Web page with the link to your live event, insert the live tags using
the following format:

<!--@Rastart event="Brief Event Description"
start="Thu, 11 Apr 1996 20:30:00 EST" -->
(some HTML that describes the event)
<!--@RAend-->

 Note: For more information about the live tag, refer to:
http://www.real.com/help/content/livetags.html

2. Send e-mail to: live_event@real.com. Do not enter a subject. In the body
of the e-mail, enter the complete URL for the page containing the live tags
(for example: http://www.real.com/example/tags.html). A software Robot
gathers the information in your live tags. The data is verified by a staff
member of Timecast and posted.

 Note:   It is very important that you include the full address, including the
“http://” part. If you use frames, be sure to send the address for the event
page that appears within a frame, not the HTML page that creates the
frames.
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Configuring Your Web Site

After encoding your RealMedia files, you are ready to attach the files to Web
pages. The following sections explain the construction and use of RealMedia
content on your Web site. When you have your RealServer set up, use this
information to showcase audio and video content from your site.

Making the Most of Your Content

To get the most out of your RealMedia content, educate your Web site’s visitors
about RealAudio and RealVideo. Let people know that they can listen and view
your clips instantly, without download delays. Identify each clip with a Real
bubble icon to distinguish it as real-time audio and video.

The graphics are available from the RealNetworks Web site at

www.real.com

on the “Logos and Trademarks” page. Make it easy for your visitors to get
RealPlayer by linking the graphics to the RealNetworks home page at:

www.real.com/
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Metafiles

 RealMedia material is reached via links, just as HTML documents use
hyperlinks to connect Web pages. However, the RealAudio and RealVideo links
you put into your HTML pages are not direct references to the RealAudio or
RealVideo files. Instead they are references to text files which contain
information needed to establish a connection between your RealServer  and
your listener’s RealPlayer and to initiate playback. These files are called
metafiles.

Metafiles contain the addresses of RealAudio (.ra) and RealVideo (.rm) files.
These addresses are in the form of URLs. They begin with a locator type,
followed by a specific address. The locator type identifies the protocol used to
exchange information between client and server. Common locator types include
http and ftp.

The locator type used by RealNetworks software is pnm (Progressive Networks
Metafile). Addresses you put into a metafile begin with pnm://

To create a link between two of your Web pages, you might add the following
text to an HTML document:

<A HREF="sect2.htm">Continue to Section 2</A>

A visitor to your site could click the text, and your Web server would then
deliver the appropriate section of your document.

If you employed the same syntax to create a link to a RealAudio and RealVideo
file, your visitor’s click would prompt your Web server to deliver your clip. But,
your Web server cannot stream RealAudio and RealVideo for real-time
playback. Only your RealServer  can do that.

Your Web server can, however, convey information to a user’s RealPlayer that
enables that Player to establish a direct connection to your RealServer . Once in
place, this direct connection is used to stream to the Player and to carry
commands (such as seek or pause) back to your RealServer .

Instead of pointing to a file, your Web page is set up to point to a metafile. This
metafile, in turn, contains the URL (Uniform Resource Locator) of the file (or
files) you want associated with the hyperlink. The user’s browser passes the
URLs to RealPlayer, which retrieves .ra or .rm files from your RealServer .
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Creating Metafiles

Your Web pages will link to metafiles, which in turn point to the DNS name or
IP address of the computer on which your RealServer and RealMedia files are
located.

If you are using RealFlash Animation, you’ll include that information in the
metafiles.

To create a metafile:

1. Use a text editor (such as Notepad) to create a file containing the
RealAudio or RealVideo URL. The contents of your file should be in the
following form:

pnm://hostname/path/filename

 where hostname is the name of your Web server, path is the path to the
file (relative to the BasePath of the RealServer), and filename is the name
of the file ending with .rm, .ra, or +.swf.

 For example, to provide access to a RealVideo file called hello.rm, the
text of your metafile would be:

pnm://www.server1.com/hello.rm

 where www.server1.com is the DNS name of the machine running
your RealServer , on which you store your RealAudio or RealVideo files.

 If you want more than one file to play in sequence when the user clicks
your link, create a metafile containing several URLs (on separate lines with
no intervening blank lines). For example, if your metafile contains:

pnm://www.server1.com/hello.rm
pnm://www.server1.com/welcome.rm
pnm://www.server1.com/coolstuff.rm

 the Player automatically plays your three files in sequence. A listener can
use the Clip menu on the Player to move forward and backward between
clips (.rm files).

 If you are using RealFlash Animation, combine the audio file name with
the RealFlash file name using the plus (+) sign:

pnm://www.server1.com/hello.rm+hello.swf
pnm://www.server1.com/welcome.rm
pnm://www.server1.com/coolstuff.rm
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2. Save your metafile in the “All files (*.*)” format, using a .ram file name
extension.

 For example, you could save the three lines shown above in a file named
welcome.ram on your Web server.

3. In your HTML document, reference the metafile in a hyperlink, followed
by a reference to the Real icon (so that the Real icon is displayed to the left
of the file) as follows:

<A HREF="http://www.real.com/welcome.ram"> <IMG
SRC="http://www.real.com/pics/rvfile.gif"
align=left border=0> Welcome!</A>

 where welcome.ram is the metafile.

File Name Extensions

Each metafile that you create must be saved with (or renamed to have) a file
name extension. This extension tells your Web server what the metafile is, to
ensure that the enclosed URL is handled properly.

There are two metafile types: .ram and .rpm. These different file name
extensions are passed on by your Web server and, ultimately, tell the user’s
Web browser which application to launch to play the referenced file:

.ram file – Browser launches RealPlayer

.rpm file – Browser launches RealPlayer plug-in (see below)

Note: You must configure your Web server to understand that the extension
.ram refers to the MIME type x-pn-realaudio and that the extension
.rpm refers to the MIME type x-pn-realaudio-plugin.

Customizing Calls to Video and Audio Content

Optional arguments may be added to metafiles to finesse what is seen and heard
by users when they click your RealAudio or RealVideo link. You may alter the
point in a clip at which play starts or ends, or the Title, Author, and Copyright
information is displayed by RealPlayer.

Add the options to your metafile following the URL to which they apply.
Options must be preceded by a ? (question mark) and separated from each other
by an & (ampersand). The syntax is as follows:
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pnm://www.real.com/test.rm?[opt1]&[opt2]

where opt is a name/value pair separated by an equal sign (=). For example,

title="mymovie"

Changing Start and Stop Times

To create a link that starts playing a clip from a point other than the beginning
of the file, use the start command. Specify the time into the clip at which play
should begin. For example:

pnm://www.real.com/test.rm?start=”30”

would result in playback starting thirty seconds into the file.

The format for the start time is as follows:

start=”dd:hh:mm:ss.ss”

Tenths of seconds are separated from seconds by a decimal point; the other
units of time are separated by colons. The time is interpreted from right to left,
and it is not necessary to specify days, hours, or minutes if these are not
relevant.

Similar to the start option is the end option. For example, the metafile text:

pnm://www.real.com/test.rm?end=”5:30”

is used to provide for playback of test.rm that terminates five minutes and thirty
seconds from the start of the clip.

Note:  The end time is always measured from the actual start of the data in the
file, even in the case where playback begins elsewhere. For example, the line:

pnm://www.real.com/test.rm?start=”30”&end=”5:30”

is used to start play of test.rm from the thirty-second mark and to stop play five
minutes later.

Changing Title, Author, or Copyright Information

The following options exist to change the descriptive information from within
the metafile:

title=”new title”
author=”new author”
copyright=”new copyright”
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Strings can be changed independently or in combination.

Changing information in this manner does not change what is stored in your
file—only what is displayed when it is accessed through this particular
metafile. This functionality is especially useful if, for example, you have one
large file that contains your band’s entire CD, and you want to credit the author
of each song as it plays. You could create a multi-clip .ram file as follows:

pnm://www.server/band.rm?end=”5:30”&title=”Song1”
pnm://www.server/band.rm?start=”5:31”&end=”7:45”&title=
”song2”&author=”Joe Smith”
pnm://www.server/band.rm?start=”7:46”&end=”15:01”&title
=”song3”&author=”Jane Smith”&copyright=”My Music, 1996”

HTTP Streaming

HTTP streaming enables content providers to stream RealAudio and RealVideo
clips from a World Wide Web server. While this method is not as robust, it
provides a reasonable method for providing short RealAudio and RealVideo
content to a limited number of users.

Before you can stream RealAudio and RealVideo clips through HTTP, you
must define the following MIME types for your World Wide Web server:

audio/x-pn-RealAudio (files with a .ra, .rm or .ram file extension)
audio/x-pn-RealAudio-plugin (files with a .rpm file extension)

video/x-pn-RealVideo (files with a .ra, .rm or .ram file extension)
video/x-pn-RealVideo-plugin (files with a .rpm file extension)

Some World Wide Web servers are pre-configured with these MIME types.

Note:  If you are running a Web page off an ISP server, send mail to the ISP
administrator asking them to configure server for the RealPlayer MIME types.

To stream RealAudio and RealVideo content using HTTP:

1. Copy your encoded RealAudio and RealVideo files (files with the .ra or .rm
extension) to your World Wide Web server.
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2. Use a text editor (such as Notepad) to create a metafile containing the
RealAudio or RealVideo URL. For example, the contents of your file
should be in the following form:

http://hostname/path/filename

 where hostname is the name of your World Wide Web server. For example:
www.real.com

 Note:  Refer to “Creating Metafiles”. This file works similarly, except it
uses http as the protocol instead of pnm.

3. Save your metafile as “All Files (*.*) using a .ram file name extension.

4. In your HTML document, reference the metafile in a hyperlink. For
example:

<A HREF="file.ram">
<A HREF="http://hostname/file.ram">

 You can use relative or complete paths. If you use complete paths, you
must include both the hostname and the complete path. For example:

<A HREF="http://www.real.com/home/welcome.ram">

5. When a user clicks on the link, the audio or video file(s) begin to
download. RealPlayer begins playing after a few seconds; it does not need
to wait for the entire file to be downloaded.

Custom Controls for RealAudio and
RealVideo

RealAudio and RealVideo enables seamless integration of RealPlayer Controls
into your Web page layout. You can place individual interactive components,
such as a play button or image window, anywhere on your page, just as you
would place an image using the <IMG> tag in HTML.

There are two products which, in conjunction with the most popular Web
browsers, enable “in page” audio controls.
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• RealPlayer plug-in provides Player-like features to browsers that support
the Netscape Navigator Plug-in architecture. This plug-in also works in
Internet Explorer 3.0.

• RealPlayer Control for ActiveX works with Internet Explorer 3.0 and
Visual Basic applications to provide RealAudio and RealVideo playback
capabilities.

Using RealPlayer Plug-in for Netscape

The Plug-in runs as an adjunct to Web browsers that support Netscape’s Plug-
in architecture. This RealPlayer Plug-in is included in the Player installation.

The <EMBED> tag specifies Plug-in attributes in HTML pages in much the
same way that the <IMG> tag specifies image attributes. The basic <EMBED>
tag for RealPlayer contains only the attributes SRC, WIDTH, and HEIGHT, as
shown below:

<EMBED SRC=metafile.rpm WIDTH=width_value
HEIGHT=height_value>

For example:

<EMBED SRC="sample1.rpm" WIDTH=300 HEIGHT=134>

creates an in-page Player that is 300-pixels wide and 134-pixels high.

For the plug-in, metafiles  are stored with a .rpm file name extension. .

The name tag is supported as an option with JavaScript to refer to a specific
plug-in.
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Feature Description

SRC Attribute The SRC attribute specifies a metafile to be accessed.
RealPlayer Plug-in is associated with a .rpm file name
extension. This extension tells the user’s Web browser
to load RealPlayer Plug-in rather than the stand-alone
RealPlayer.

For the user’s Web browser to correctly identify .rpm
files, you or your system administrator must first
configure the .rpm MIME type in your Web server.
Users do not need to configure their Web browsers to
recognize the .rpm MIME type. The plug-in
architecture automatically sends .rpm files to
RealPlayer plug-in. Files with a .rpm extension are
identical to .ram files,  except for the extension.

WIDTH and
HEIGHT
Attributes

The WIDTH and HEIGHT attributes specify the size
of the embedded RealAudio or RealVideo component.
Unlike images, Plug-ins do not size automatically. The
WIDTH and HEIGHT can be specified in pixels (the
default) or as a percentage of the Web browser window
(for example: WIDTH=100%).

Note If the WIDTH and HEIGHT attributes are not
included, the Plug-in may appear as a tiny (and
useless) icon with some browsers.

If you want your Plug-in component to maintain an
absolute size, specify HEIGHT and WIDTH in pixels.
If you want the Plug-in graphic to scale with the Web
browser window, specify size as a percentage. For
example, if you want to fit the entire width of the Web
browser window, use WIDTH=100%.
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Feature Description

CONTROLS
Attribute

The CONTROLS attribute of the <EMBED> tag
allows you to place individual control elements within
your page. You can use multiple <EMBED>
statements to construct a custom interface, made up of
individual controls. You can also place multiple
controls within a single <EMBED> statement.
CONTROLS supports the following values: All,
ControlPanel, InfoVolumePanel, InfoPanel,
StatusPanel, StatusBar, PlayButton, StopButton,
VolumeSlider, PositionSlider, PositionField,
StatusField, ImageWindow.

CONSOLE
Attribute

Sets a console name used to link multiple control
instances. All controls with the same console name
work together. For example, if you have multiple Play
and Stop buttons on the same page, the console name
would enable them to control the same RealAudio or
RealVideo clip. Call this function once for each
instance of the Play or Stop button you want to link.

The console name. “_master” links to all instances.
“_unique” links to no other instances.

AUTOSTART
Attribute

Sets whether or not the control automatically starts
playing once the source data is available. Valid values
are TRUE or FALSE.

NOLABELS
Attribute

Suppresses the Title, Author, and Copyright label text
in the controls window. The text strings in the fields
are still displayed.

RESET Attribute Resets RealPlayer Control for ActiveX playlist. Valid
values are TRUE or FALSE.

AUTOGOTOURL
Attribute

Specifies how a URL is handled. Valid values are
TRUE or FALSE. TRUE indicates that RealPlayer
Control for ActiveX automatically forwards the URL
event to the browser. FALSE indicates that the
OnGotoURL VBScript event is used instead.
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Preparing HTML Pages for Browsers that Cannot Use the
Plug-in

Some Web browsers do not support plug-ins. You can create HTML pages that
are enhanced for plug-ins but which also work for other browsers. Simply use
the <NOEMBED> tag to include HTML statements for use by Web browsers
that do not support plug-ins.

The <NOEMBED> command should appear after an <EMBED> command and
take the following syntax:

<NOEMBED> HTML to be ignored </NOEMBED>

For example, the command:

<EMBED SRC="sample1.rpm" WIDTH=300 HEIGHT=134>
<NOEMBED> <A HREF="sample1.ram"> Play the clip
using the stand-alone Player! </A></NOEMBED>

would show a page with the plug-in if your page were accessed by a browser
supporting plug-ins, and would otherwise display the message “Play the clip
using the stand-alone Player!” (and allow playback with the standard Player).
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Using RealPlayer Control for ActiveX

You can embed RealPlayer Control for ActiveX in HTML pages using the
Object tag.

The following is an example of RealPlayer Control <OBJECT> in an HTML
page.

<OBJECT
ID=RAOCX
CLASSID="clsid:CFCDAA03-8BE4-11cf-B84B-0020AFBBCCFA"
HEIGHT=140
WIDTH=312>
<PARAM NAME="SRC" VALUE="pnm://audio.real.com/file.rm">
<PARAM NAME="CONTROLS" VALUE="all">

</OBJECT>

Note:   Directory names cannot have spaces.

Embedded Object Parameters

Feature Description

OBJECT Tag is used to embed RealPlayer Control for ActiveX.
There should be one <Object> tag per RealPlayer Control
on the page.

CLASSID Specifies the control's CLSID. This value is always
“clsid:CFCDAA03-8BE4-11cf-B84B-0020AFBBCCFA”
for RealPlayer Control for ActiveX.

HEIGHT Specifies the control's height on the HTML page. A value
of 0 makes the control invisible.

WIDTH Specifies the control's width on the HTML page. A value
of 0 makes the control invisible.

PARAM Specially embedded tag for supplying parameters to the
ActiveX object.
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The following properties are available with the PARAM Parameter:

Parameter Description

SRC Sets the source of RealAudio or RealVideo clip. The
SRC location can be pnm, file or http protocol. This
parameter is required.

CONTROLS Sets the visible components of the control. Valid
CONTROLS include All, ControlPanel,
InfoVolumePanel, InfoPanel, StatusPanel,
StatusBar, PlayButton, StopButton, VolumeSlider,
PositionSlider, PositionField, StatusField, and
ImageWindow.

CONSOLE Sets a console name used to link multiple control
instances. All controls with the same console name
work together. For example, if you have multiple
Play and Stop buttons on the same page, the console
name would enable them to control the same
RealAudio or RealVideo clip. Call this function
once for each instance of the Play or Stop button you
want to link.

The console name. “_master” links to all instances.
“_unique” links to no other instances.

AUTOSTART Sets whether or not the control automatically starts
playing once the source data is available. Valid
values are TRUE or FALSE.

NOLABELS Suppresses the Title, Author, and Copyright label
text in the controls window. The text strings in the
fields are still displayed.

RESET Resets RealPlayer Control for ActiveX playlist.
Valid values are TRUE or FALSE.
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Parameter Description

AUTOGOTOURL Specifies how a URL is handled. Valid values are
TRUE or FALSE. TRUE indicates that RealPlayer
Control for ActiveX automatically forwards the URL
event to the browser. FALSE indicates that the
OnGotoURL VBScript event is used instead.
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Specifying How the Control Should Look

The CONTROLS attribute allows you to place individual control elements
within your page. The CONTROLS attributes for the Netscape Navigator plug-
in and RealPlayer ActiveX Control are the same. The following explains the
output of each attribute:

All - Displays a full Player view including the Control Panel, Information-and-
Volume Panel and Status Bar.

Minimum Width: 21% Maximum Width: 100%
Minimum Height: 23% Maximum Height: 80%

InfoVolumePanel - Displays the Title, Author, and Copyright information
panel and the volume slider.

Minimum Width: 21% Maximum Width: 100%
Minimum Height: 12% Maximum Height: 50%
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InfoPanel - Displays the Title, Author, and Copyright information.

Minimum Width: 20% Maximum Width: 100%
Minimum Height: 10% Maximum Height: 50%

ControlPanel - Displays the play/pause button, the stop button and the position
slider.

Minimum Width: 21% Maximum Width: 100%
Minimum Height: 8% Maximum Height: 25%

StatusPanel - Displays the Status Panel showing informational messages,
current time position, and clip length. If you do not embed a Status Panel in
your page, error messages are displayed in the Web browser’s status bar.

PlayButton - Displays the play/pause button.

Minimum Width: 5% Maximum Width: 100%
Minimum Height: 2% Maximum Height: 25%
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StopButton - Displays the stop button.

Minimum Width: 5% Maximum Width: 100%
Minimum Height: 2% Maximum Height: 25%

VolumeSlider - Displays the volume slider.

Minimum Width4% Maximum Width100%
Minimum Height10% Maximum Height100%

PositionSlider - Displays the position slider.

Minimum Width 8% Maximum Width 100%
Minimum Height 5% Maximum Height 25%

PositionField - Displays the field of the Status Bar showing position and clip
length.

Minimum Width: 10% Maximum Width: 100%
Minimum Height: 4% Maximum Height: 25%
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StatusField - Displays the message text area of the Status Bar.

Minimum Width: 13% Maximum Width: 100%
Minimum Height: 4% Maximum Height: 15%

ImageWindow - Displays the video image. (Only available for .rm files)

Minimum Width: 100% Maximum Width: 100%
Minimum Height: 100% Maximum Height: 100%

StatusBar - Displays the status field, position field, channels (stereo/mono).

Minimum Width: 21% Maximum Width: 100%
Minimum Height: 5% Maximum Height: 14%
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ActiveX Methods and Properties

Methods

Methods are functions that control the performance of the Control. Unless otherwise noted,
these methods have no return values and no parameters.

Method Description

DoPlayPause Plays or pauses the current clip. Equivalent to clicking the Play/Pause
button.

DoStop Stops the clip. Equivalent to clicking the Stop button.

DoNextItem Skips to the next clip in a .ram file that contains multiple clips. A .ram
file is a metafile that points to one or more RealAudio or RealVideo
files.

DoPrevItem Skips to the previous clip in a .ram file that contains multiple clips. A
.ram file is a metafile that points to one or more RealAudio or
RealVideo files.

CanPlayPause Tests if Play/Pause function is available. Returns TRUE or FALSE

CanStop Tests if Stop function is available. Returns TRUE or FALSE.

HasNextItem Tests if the next clip function is available. The next clip function is
available when the connected source is a .ram file that contains
multiple clips, and the current clip is not the last clip in the .ram file.
Returns true or false.

HasPrevItem Tests if the previous clip function is available. The previous clip
function is available when the connected source is a .ram file that
contains multiple clips, and the current clip is not the first clip in the
.ram file. Returns true or false.

AboutBox Opens the Copyright information for the control.

EditPreferences Opens the Preferences dialog box. Enables the end user to set his/her
preferences. These preferences are global to all RealAudio or
RealVideo clients on the machine.

HideShowStatistics Shows or hides the Connection Statistics dialog box.

IsStatisticsVisible Tests if the Connection Statistics dialog box is displayed. Returns true
or false.

DoGotoURL(url,
target)

Causes the control to attempt a navigation to the specified URL in the
specified frame target. The container must support URL browsing.
Parameters: string URL, string target.
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Object Properties

The object properties are set within Visual Basic and specify properties about the control.

Property Description

Source Specifies the URL of the clip to play. The Source location can be pnm:,
file: or http: protocol.

Controls Returns/Sets the visible components of the control. Valid CONTROLS
include ALL, ControlPanel, InfoVolumePanel, InfoPanel, StatusBar,
StatusPanel, PlayButton, StopButton, VolumeSlider, PositionSlider,
PositionField, ImageWindow and StatusField.

Console Sets a console name used to link multiple control instances. All controls
with the same console name work together. For example, if you have
multiple Play and Stop buttons on the same page, the console name
would enable them to control the same clip. Call this function once for
each instance of the Play or Stop button you want to link. The console
name master links to all instances while _unique links to no other
instances.

Autostart Sets whether or not the control automatically starts playing once the
source data is available. Valid values are TRUE or FALSE.

NoLabels Suppresses the Title, Author, and Copyright label text in the controls
window. The text strings in the fields are still displayed.

AutoGotoURL Specifies how a URL will be handled. Valid values are TRUE or
FALSE. TRUE indicates that the RealPlayer ActiveX Control will
automatically forward the URL event to the browser. FALSE indicates
that the OnGotoURL VBScript event will be sent instead.
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Java and JavaScript Methods
Methods are functions that control the performance of the Java enabled RealPlayer Plug-in.

Method Description

SetSource(String
Source)

Specifies the URL of the RealAudio clip to play. The Source location
can be pnm:, file: or http: protocol.

SetControlsString(String
ControlsString)

Returns/Sets the visible components of the control. Valid CONTROLS
include ALL, ControlPanel, InfoVolumePanel, InfoPanel, StatusBar,
PlayButton, StopButton, VolumeSlider, PositionSlider, PositionField,
and StatusField.

SetConsoleName(String
ConsoleName)

Sets a console name used to link multiple RealVideo plug-in instances. All
Plug-ins with the same console name work together. For example, if you
have multiple Play and Stop buttons on the same page, the console name
would enable them to control the same clip. Call this function once for each
instance of the Play or Stop button you want to link. The console name
master links to all instances while _unique links to no other instances.

SetAutoStart(Boolean
bAutoStart)

Sets whether or not the plug-in  automatically starts playing once the
source data is available. Valid values are TRUE or FALSE.

SetNoLabels(Boolean
bNoLabels)

Suppresses the Title, Author, and Copyright label text in the Plug-in
window. The text strings in the fields are still displayed.

DoPlayPause() Plays or pauses the current clip. Equivalent to clicking the Play/Pause
button.

DoStop() Stops the RealAudio clip. Equivalent to clicking the Stop button.

DoNextItem() Skips to the next clip in a .ram file that contains multiple clips. A .ram
file is a metafile that points to one or more RealAudio files.

DoPrevItem() Skips to the previous clip in a .ram file that contains multiple clips. A
.ram file is a metafile that points to one or more RealVideo files.

CanPlayPause() Tests if Play/Pause function is available. Returns TRUE or FALSE

CanStop() Tests if Stop function is available. Returns TRUE or FALSE.

HasNextItem() Tests if the next clip function is available. The next clip function is
available when the connected source is a .ram file that contains
multiple clips, and the current clip is not the last clip in the .ram file.
Returns true or false.

HasPrevItem() Tests if the previous clip function is available. The previous clip function is
available when the connected source is a .ram file that contains multiple
clips, and the current clip is not the first clip in the .ram file. Returns true or
false.

AboutBox() Opens the Copyright information for the control.

EditPreferences() Opens the Preferences dialog box. Enables the end user to set his/her
preferences. These preferences are global to all clients on the machine.

HideShowStatistics() Shows or hides the Connection Statistics dialog box.
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IsStatisticsVisible() Tests if the Connection Statistics dialog box is displayed. Returns true or
false.

CallBack Methods

CallBack methods are functions that provide notification from the RealAudio or RealVideo
engine. CallBack methods can only be used with Java applets by implementing the
RAObserver interface.

Method Description
onClipOpened(String
shortClipname, String
URL)

Sent when a clip has been opened.

onClipClosed() Sent to indicate that no clip is currently open.

onShowStatus(String
status)

Sent to indicate that the status text is changing.

setAutoGoToURL(boolean
bAutoGoToURL)

Specifies how a URL will be handled. Valid values are true or
false. True indicates that the RealPlayer plug-in  will
automatically forward the URL event to the browser. False
indicates that the OnGoToURL event will be handled by the
Java applet instead.

onGoToURL(String url,
String target)

Sent when a URL event has been encountered for the
currently playing clip. This event will only occur if the
AutoGotoURL property is false.
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Advanced Control Attributes

The more exciting features of RealPlayer plug-in and RealPlayer Control for
ActiveX may be utilized by specifying custom attributes within your HTML
documents.

Removing Text Labels from Controls

If your Web page is in a language other than English, or if you want to use the
Description fields to display information other than Title, Author, and
Copyright, you may remove the Title, Author, and Copyright Labels from the
information area. Controls that display Title, Author, and Copyright
information for a clip, support a NOLABELS=TRUE attribute.

For example, allowing the default behavior

<EMBED SRC="use_lbl.rpm" WIDTH=350 HEIGHT=80
CONTROLS=InfoPanel>

or specifying NOLABELS=FALSE

<EMBED SRC="use_lbl.rpm" WIDTH=350 HEIGHT=80
CONTROLS=InfoPanel NOLABELS=FALSE>

results in the following display.

On the other hand, using NOLABELS=TRUE, for example:

<EMBED SRC="no_lbl.rpm" WIDTH=350 HEIGHT=80
CONTROLS=InfoPanel NOLABELS=TRUE>

produces the following InfoPanel:
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Starting Clips Automatically

Adding an AUTOSTART=TRUE attribute tells the user’s browser to
automatically begin playing your clip when the page is visited. You can use this
feature to begin narration, to play a welcome message or start a video.

Since only one clip can play at a time, if you specify AUTOSTART for more
than one control instance, only the last control to load will play. The order in
which your files are delivered is dependent on the Web server and on the
browser’s cache size. This is not necessarily the order in which you put them
within your HTML. Therefore, you should specify AUTOSTART for only one
control instance per page.

Playing Clips with a Hidden Control or Plug-in

If you want to play RealAudio or RealVideo clips without having a visible Plug-
in control, you hide the control. By embedding a Plug-in in your page that has
its size set to width=2 height=0, no image appears on your Web page. You can
control the Plug-in with JavaScript.

For example:

<script Language=JavaScript>
function playSource()
{if (navigator.appName == "Netscape")

{document.javaPlug1.DoPlayPause();}
else

{RAOCX.DoPlayPause();}
}
</script>
<A HREF="#" onClick="playSource()"><IMG

SRC="button.gif"></A>
<OBJECT ID=RAOCX CLASSID="clsid:CFCDAA03-8BE4-11cf-B84B-

0020AFBBCCFA" WIDTH=2 HEIGHT=0>
<PARAM NAME="SRC" VALUE="pnm://audio.real.com/welcome.rm">
<PARAM NAME="CONTROLS" VALUE="PlayButton">
<embed src="start.rpm" Width=2 Height=0

Controls=PlayButton name=javaPlug1>
</OBJECT>

The above example works in both Netscape and Internet Explorer. Only one
control will appear on the Web page.

Making Controls Work Together

You can embed any number of RealPlayer controls within a Web page.
Normally, each tag instance refers to different content. Sometimes, however,
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you may want to link two or more controls together. For example, you can
create a play button and an image window that work as a pair.

To include multiple components that work together, specify a CONSOLE
attribute for each control and assign this the same value in each instance. For
example:

<EMBED SRC="sample1.rpm" WIDTH=30 HEIGHT=33
CONTROLS="PlayButton" CONSOLE="Clip1">

<EMBED SRC="empty1.rpm" WIDTH=176 HEIGHT=144
CONTROLS="ImageWindow" CONSOLE="Clip1">

Note Each <EMBED> tag must have a unique SRC attribute (if the same
source is specified for two tags, one is ignored). Create a dummy .rpm file
(named, for example: empty1.rpm) for a second control accessing a clip. Put a
hard carriage return (ASCII code 13) into the dummy file.

Specifying a CONSOLE value of “_master” links a particular control to all other
RealPlayer Controls on the page. Use this value, for example, to add a Status
Bar to display information for all clips, for example:

<EMBED SRC="sample1.rpm" WIDTH=300 HEIGHT=33
CONTROLS="StatusBar" CONSOLE="_master">

Because many platforms, including Windows, only support one volume setting,
all volume sliders act on the same underlying value and affect all clips
regardless of CONSOLE name. For this reason, you may want to include only
one volume slider per page, with no reference to a .rm file in its associated .rpm
file.

If you only include an ImageWindow control on the Web page, the video
stream may still be controlled by using the context sensitive pop-up menu. For
Windows users, right-click the ImageWindow; Macintosh users, click and hold
the mouse button until the pop-up menu appears.

Frame Document

A frame document describes the sub-HTML documents or frames that make up
a window. The basic structure of a frame document is similar to that of a
normal HTML document except that the FRAMESET tag replaces the BODY
tag. Each frame is defined by the FRAME tag. In order to effectively use
RealVideo, each FRAME tag needs the SRC and NAME attributes. The SRC
points to the URL to be displayed in the frame. The NAME attribute assigns a
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name to the frame so that it can be targeted by links in other documents. The
example below shows a simple frame document that would create two frames:

<HTML>
<FRAMESET ROWS="105,*">

<FRAME SRC="banner.html" NAME="banner">
<FRAME SRC="lyrics.html" NAME="Lyric">

</FRAMESET>
</HTML>

Synchronizing Frames and Video and Audio

Frames and RealVideo and RealAudio content are synchronized in the same
way that a regular Web page and RealVideo and RealAudio content are
synchronized: a .rae file. The difference lies in the addition of the targeted
frame name to the text file that is used to create the .rae file. The syntax for
each entry should follow the format:

u starttime endtime &&framename&&EventURL

where:

u stands for URL event (each line starts with the letter u)
starttime is the time into the clip when the new event is shown
endtime is the time into the clip when that event ends, && is a delimiter
framename is the frame name as specified in your frame document
EventURL (generally beginning with "http:" or "file:") is the URL for that
event (usually an HTML document).

The time format is:

 [[[days:]hours:]minutes:]seconds[.tenths]

The lines of the input file must be in ascending order of start time. The end
time should be at least one tenth of a second before the start time for the next
event.

The example below shows an .rae input file for a Web site that displays lyrics
as a song plays. Each verse is displayed within a frame called Lyric.

u 00:00:10.0 00:00:35.0
&&Lyric&&http://www.songs.com/ver1.html
u 00:00:35.0 00:00:50.0
&&Lyric&&http://www.songs.com/ver2.html
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Note: You cannot use frames within a presentation using RealPlayer as a
helper application. You can only use frames within a multimedia presentation
using the Plug-in or ActiveX Control.

More Information on Frames

A complete discussion of frames is beyond the scope of this manual. For more
information on frame attributes and syntax and on targeting windows consult
the following Web pages:

Frames -- Syntax

http://www.netscape.com/assist/net_sites/frame_syntax.html

Targeting Windows

http://www.netscape.com/eng/mozilla/2.0/relnotes/demo/target.html
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Content Creation for Internet
Appliances and Set-top Boxes

Recently, there has been a significant increase in the number of appliances such
as televisions, Internet phones etc. that are able to view content resident on
servers on the World Wide Web. Increasingly, these appliances will also have
the capability to view and play RealAudio and RealVideo content. While these
devices may be able to play RealAudio or RealVideo, they are often constrained
in various ways. Some examples of these constraints include:

• Their Internet connections are at relatively low bit rates.

• They may not have the capability to playback RealVideo.

• They may be able to playback content that uses only the RealVideo
(Standard) codec.

To make your content accessible by this increasingly large user population, we
strongly recommend creating content in a variety of formats that are playable
both on RealAudio and RealVideo players running on PCs and workstations as
well as appliances. To do so, you can take advantage of RealAudio and
RealVideo's many codec offerings and do one or more of the following:

• If you choose to use the RealVideo (Fractal) codec to create high-quality,
high bandwidth content, you may also wish to use the RealVideo
(Standard) codec to create a lower bit-rate version of the same content. The
same strategy could be used if you are creating high bandwidth content
using RealVideo(Standard).

• Create links on your Web-pages to audio-only versions of video
presentations. These audio-only versions can be created at multiples
bandwidths (using bandwidth negotiation). You may also wish to create
content using codecs that are part of RealAudio Encoder 3.0 to
accommodate users that may have audio players.
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• Another alternative would be to use bandwidth negotiation and create high
bandwidth RealVideo content and low bandwidth RealAudio versions of
the same content, ie. pnrv.20 and 14_4.18 would play video to RealPlayers
4.0 and 5.0 and 14.4 audio to any other.
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Command Line Parameters
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Editing File Properties, 84–86
Editing RealAudio and RealVideo Data, 87–
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modifying descriptions, 103
requested in bandwidth negotiation, 65–71
supported by Adobe Premiere, 76
supported for static encoding, 26–30

Fixed Frame Rate, 46, 48, 50, 74
Frame Rate, 23, 37, 43, 46, 48, 50, 56, 74,

115, 118, 120, 122
Frames, 82

frame document, 155
synchronizing with audio, 156

H
HTML Generation Wizard, 105
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HTTP Web Server, 7

I
Image Cropping, 51
Image Map, 99–103

creating image map file, 99–102
merging with video image, 102

Image Map Example, 102
Image Size, 51
Input Events File, creating, 80
Installing RealEncoder

on Macintosh, 16
on Windows, 14–15

Installing RealPublisher
on Windows, 14–15

ISDN, 1, 6, 41, 44, 64–67, 65, 69, 71

J
Java and JavaScript

callback methods, 152
controlling RealPlayer plug-in performance,

151–52

L
Latency, 46, 122
Live Broadcasts

archiving, 126–28
Live Content

designing templates, 115
producing high quality, 120
saving as file, 115
settings, 57
using RealServer for delivery, 115–17

Live Encoding and Broacasting
with synchronized Web pages, 124–26
with video image maps, 124–26

Live Encoding and Broadcasting, 13, 121–23
advertising your event, 129–31
command line encoding, 34–36, 123
content settings, 57
creating new templates, 43–50
creating synchronized multimedia, 124–26

delivering live content with RealServer,
115–17

delivering RealAudio and RealVideo
Content, 118

LiveFilePassword, 115
LiveFileTarget, 115, 127

LiveFilePassword, 127

M
MAP tag, 100
Marker options in Adobe Premiere, 76
Merging Image Maps with Video, 102–3
Metafiles, 8, 13, 133–37, 135

automatic creation by RealPublisher, 107
changing start and stop times, 136
changing title, author or copyright, 136
creating, 134
customizing calls to video and audio

content, 133–37
plug-in files, 139
table of, 64

Methods
controlling performance of Control, 149

Modifying RealAudio and RealVideo Clips,
12

Modifying RealAudio and RealVideo File
Descriptions, 103

Multi-template Encoding, 42–43

N
Netscape Web Browsers. See RealPlayer
New Templates

command line parameters, 44–46
creating, 43–50
creating for Windows, 47

NOLABLES
available with PARAM parameter, 143

O
Optimized Frame Rate, 46, 48, 50, 74



RealAudio and RealVideo Content Creation Guide

166

P
Perfect Play, 13, 31, 33, 35, 75, 86
plug-in, 6

adjunct to Web browsers, 139
AUTOGOTOURL attribute, 141
AUTOSTART attribute, 141
CONTROLS attribute, 140, 145
customized page controls, 145–48
customizing Control Attributes, 153
for Adobe Premiere, 25, 73–75, 73, 76
for Adobe Premiere on Macintosh, 19
for Adobe Premiere on Windows, 17
for browsers, 138
height and width attributes, 140
hidden, playing clips with, 154
launched by .ram file, 135
launched by .rpm file, 135
MIME type, for HTTP streaming, 137
NO LABEL attribute, 141
RESET, 141
SCR attribute, 139
setAutoGoToURL method, 152
storing metafiles with .rpm extension, 139
using SetAutoStart method, 151
using SetConsoleName method, 151
using when unsupported by Web browsers,

141
using with embedded RealPlayer, 106–7
using with Netscape browsers, 139–41
using with synchronized multimedia, 78

RealPlayer, 139
Plug-in,metafile, 8
PnaPort, 115
Pop-up RealPlayer, 105–6
Pre-defined Template Names, 39–42
Pre-defined Templates, 39–42
Producing High Quality Audio, 56
Producing High Quality Video, 55
Publishing to the Web, 105–8

creating Web pages, 105–7
Publishing Wizards, 105–7
Publish-to-Server Wizard, 108

Q
QuickTime Requirements, 29

R
rafile

manually archiving live broadcasts, 127
using for archiving live broadcasts, 126

Real Icon, 132
RealAudio and RealVideo

modifying clips, 12
RealAudio Clip, 6
RealEncoder, 7

Adobe Premiere plug-in, 73–75
connecting to RealServer, 116
editing RealAudio and RealVideo files, 83–

104
encoding live content, 121–23
encoding static files for Macintosh with,

32–34
encoding static files with, 26–30
files installed on Macintosh, 19
files installed on Windows, 17–18
installing on Macintosh, 16
performance range, 1
supported audio formats, 26
supported video formats, 26
system requirements, 20–24
types of encoding, 25

RealFlash, 134
RealMedia Clip, 8
RealPlayer, 6, 8, 10, 11, 12, 13, 32, 34, 52,

55, 63, 66, 72, 75, 78, 81, 86, 89, 91, 93,
101, 103, 105, 106, 113, 120, 122, 133,
135, 139
ActiveX Control, 142
ActiveX plug-in for Web page embedding,

106–7
AUTOGOTOURL attribute for plug-in, 141
AUTOSTART attribute for plug-in, 141
browser plug-ins, 138
configuring mime type, 137
CONSOLE attribute for plug-in, 140
control for ActiveX, 138
Controls, 138
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CONTROLS attribute for plug-in, 140
creating Web pages with, 105–7
customized page controls, 145–48
embedded, 105
NOLABEL attribute for plug-in, 141
plug-in, using with synchronized

multimedia, 78
pop-up, 105
ram file, plug-in launched by, 135
RESET attribute for plug-in, 141
rpm file, plug-in launched by, 135
setAutoGoToURL method for plug-in, 152
SRC attribute, 139
SRC attribute for plug-in, 139
storing metafiles for plug-in, 139
using plug-in with advanced control

attributes, 153
using plug-in with Netscape browsers, 139–

41
WIDTH and HEIGHT attributes for plug-

in, 140
RealPlayer Active X Control. See Embedded

Object Parameters
RealPublisher, 7

Adobe Premiere plug-in, 73–75
connecting to RealServer, 116
creating metafiles automatically, 107
creating Web pages, 105–7
editing RealAudio and RealVideo files, 83–

104
encoding live content, 121–23
encoding static files with, 26–30
files installed on Windows, 17–18
installing on Windows, 14–15
performance range, 1
publishing to the Web, 105–8
supported audio formats, 27
supported video formats, 27
system requirements, 20–24
types of encoding, 25
using wizards, 105–7

RealServer, 4, 5, 7, 8, 10, 12, 14, 33, 38, 63,
70, 72, 108, 110, 112, 113, 115, 116, 133,
134
configuring to archive automatically, 127

configuring to archive manually, 127
delivering live content, 115–17

RealVideo (Fractal) Codec, 45, 158
RealVideo (Standard) Codec, 45, 158
RealVideo Clip, 6
RealVideo Simulated Live Transfer Agent, 18,

116, 128, 129
RESET

available with PARAM parameter, 143
RM Tools

editing file data, 87–91
RMCut, 7, 17, 91, 93–94, 93, 94
RMDump, 17, 83, 91, 92, 94–96, 94
RMEdit, 7, 17, 83, 91–98, 91, 92, 103
rmfile

manually archiving live broadcasts, 127
using for archiving live broadcasts, 126

RMMerge, 7, 17, 18, 78, 79, 102, 103, 125
RMPaste, 7, 18, 83, 91, 93, 97–98, 97
RMTools, 7, 18, 83, 84, 86, 87, 103

editing file properties, 84–86
examining file contents, 86
tasks associated with, 83

RVBatch, 18, 34, 36, 38
RVEncode, 18
rvslta, 18, 116, 128, 129

using, 128

S
Sampling Rate, 57, 58, 59
Selective Record, 13, 34, 35, 75, 84, 86, 92,

103, 122
Sound Card, 21, 22, 118
Source Files for Static Encoding, 26–30
SRC

available with PARAM parameter, 143
Static Encoding, 12, 20, 24, 25, 26–30, 32–34,

123
Streaming Files

from HTTP Web server, 111, 137–38
Synchronized Multimedia, 5, 8, 78, 80, 82

creating for live broadcast, 124–26
creating for RealAudio, 79–80
delivering, 11–12
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frames, 82
from local files, 81
using with Bandwidth Negotiation, 82

Synchronized Web Pages
enhancing live broadcasts with, 124–26

Synchronizing Audio with Video, 58
System Requirements, 20–24

for Macintosh platform, 24
for Windows platforms, 21–24
live encoding RealAudio, 21
live encoding RealVideo, 23
static encoding RealAudio, 21, 24
static encoding RealVideo, 22, 24

T
T1, 1, 64, 65, 67, 70, 71
Template Names

for pre-defined templates, 39–42
Templates

command line parameters for new, 44–46
creating new, 43–50
designing live encoding templates, 115
multiple, 42–43
pre-defined, 39–42
using, 36–47

Timecast
advertising with, 130

Title, Author, and Copyright, 13
changing within metafiles, 136
modifying text, 103

Total Bit Rate, 43, 44, 45, 47, 49, 50, 74, 120

V
Video Bit Rate, 42, 43, 44, 45, 47, 49, 83
Video Capture Card, 22, 115
Video Codecs, 28, 29, 36, 37, 45, 47, 49, 74

RealVideo (Fractal), 45, 158
RealVideo (Standard), 45, 158

Video For Windows-capable capture card, 23,
118

Video Image Map
enhancing live broadasts with, 124–26

Video Input Devices, 55
Video Quality

content elements affecting, 56
using video input devices, 55

VisualBasic
object control properties, 150

Volume Control, 53

W
Web Browser, 7
Web Page Creation, 105–7

using HTML Generation Wizard, 105–7
with embedded RealPlayer, 106–7
with pop-up RealPlayer, 105–6, 105–6

Web Site Configuration, 132
Windows

drag-and-drop encoding, 51
Wizards

publishing, 105–7


